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The following Help Topics are available:

@
Quick Tour

Searching the Encyclopedias
@
Using the Dictionaries

b

Viewing and Navigating Multimedia

Bookmarks
e
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e
Quiz

b

Screens

b

Reference

b

Contacting TCE

For further information when viewing the above topics follow the links in green or click the Contents
Button.
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Preferences

Modifies settings that control screen appearances. Open the Preferences window by choosing
"Preferences..." from the File Menu.

| Illustration I
Click the button to see the Preferences window.

1 Save Current Article on Exit
Choose this option to display the last article viewed in the current session as the first article viewed in the
next session. If this option is not selected, the program opens with the first article in the encyclopedia.

2 Show Pictures (Thumbnails) when Displaying Articles
Select Show Pictures when Displaying Articles to display thumbnails (small representations of multimedia
items) in the text. Screen redraws will be faster with this preference turned off.

3 Show Opening Animation
Change this option if you do not want to play the opening animation when the program begins.

4 Set Slide Show Delay
Set the number of seconds delay before the next picture appears in the slide show.

5 Text Fonts
Changes the style and size of the text fonts.

6 Set Colours
Select colours for highlighting, cross references and search terms.
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Buttons

Buttons are used throughout the program to launch a particular action. These buttons are explained
throughout this Help program and in brief terms below:

Add Bookmark

Advanced

Anagram

Begin Search
Bookmark

Bookmark List Note
Boolean Search
Canadian Firsts

Caption

Clear Entry
Close

Close Media
Clue

Contents
Definition
Dictionary
Dictionary Display
English-French
French-English
Go to Article

Help

Highlight

Hint

Last Article
Media

Media by Subject
More in Subject
New List

New Question
Notes

On This Day
Open List
Periods

Play Sound
Preview
Previous

Print
QuickSearch
Related

Quiz

Save List
Search by Date
Search Subjects
Scramble

Slide Show
SmartSearch
Solve

Spelling On/Off




Tuner
Thesaurus
View Legend
Year in Review
Wildcard
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Menu Functions

To choose a command from a menu:
1 Point to the menu name and click the mouse.
2 Point to a command listed on the menu and click the mouse.

Keyboard Shortcuts
Keyboard shortcuts are available for many functions. See Keyboard Commands.

Click on the items below for a description of each menu:

3

File Menu

[

Edit Menu

3

Navigation Menu
3

Mode Menu

3

Bookmark Menu
3

Search Menu

3

Article Menu

Help Menu

L

Puzzle Menu

L

Question Menu

Control Menu

b 2

Dictionary Menu

L

Options Menu
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=

Printing

2
To Print an Article
The printing option is available in the File Menu or via the Print Button when you are in the Encyclopedia

and Dictionary windows. (Note that the Print Button is replaced by a Highlight Button when an article is
marked as part of a Bookmark List.

»
To Print Part of an Article (Windows only)

To print part of an article, Select the text with the left mouse button (see Selecting Text) choose "Print
Article ..." from the File Menu. When text is selected, a dialog box appears. Choose the "Print selected
text" option and click OK.

| Related Topics |
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[ ]

Saving
Save an article or selected text in the following manner:

b 2

Saving an Article

1 Choose "Save Article ..." from the File Menu to display the file save dialog box.
By default, the program saves to the Canadian Encyclopedia directory that was created when you
installed the program. Click here to see how to Change the Path.

2 In the dialog box, type the name of the file you wish to save in the File box.

L 2

Saving Selected Text
1 Select the Text with the Mouse (see Selecting Text)

Then choose "Save Article ..." from the File Menu (or click Ctrl+S)
2 On the Save dialog box, choose "Save the Selected Text."

If no text is selected, this option does not appear.

Please Note:

Files are saved in a standard format and can be loaded easily into your word processor.

| Related Topics |
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Copying

You can copy text to the clipboard in ASCII format. From the clipboard the copied text can be copied to
any word processor, to any find or search dialog box or to your General Notes in a Bookmark List.

b 2

To Copy Selected Text to the Clipboard

1 Select text by dragging the mouse button (see Selecting Text)

2 Choose the "Copy Selected Text" option from the Edit Menu in the Encyclopedia Window.
Or use the keyboard command Ctrl+C (Windows) or Command+C (Macintosh).

To Copy Selected Text into a Bookmark List

Click here for Copying Text to an Article Note

Click here for Copying Text to an Bookmark List Note

To Paste Selected Text into your Word Processor

1 Copy the text to the clipboard as described above.

2 Open your word processor document and click the paste button or use the command SHIFT+INSERT
(Command+V on a Macintosh).

b 2

To Paste Selected Text into a find or search dialog box

1 Copy the text to the clipboard as described above.

2 Open the search or find dialog box and click in the text entry box. Use the command Ctrl+V
(Command+V on a Macintosh) to enter the text.

L
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Abbreviations

Abbreviations are used throughout the text of The Canadian Encyclopedia Plus. Most of these
abbreviations are listed below. Go to the section of the alphabet that contains the abbreviation and click
the abbreviation to display the full term. Click "Back" on the menu bar at the top of the screen to return to
this screen.

L 2

Abbreviations A-B

Abbreviations C

&

Abbreviations D-E

L 2

Abbreviations F-G

Abbreviations H-L

L 2

Abbreviations M

&

Abbreviations N-O

Abbreviations P-Q
e

Abbreviations R-S

L

Abbreviations T-U

Abbreviations V-Y



Navigating Within the Article Text

Jumping to a Section within an Article:
Use the Article Contents Button to jump to a sub-heading or to a multimedia item within an article.

Moving through the Text Using the Scroll Bar

Click on the scroll arrows ™ to move up or down one line at a time

b2

Drag the scroll box Bl up and down to move to a new position in the text

Click on the open scroll arrows = to move to the next highlighted search term in the article following a
search

L

Moving through the Text Using the Keyboard
Press the up and down arrow keys to move up or down one line.
Press HOME to return to the beginning of the article.

Press END to move to the end of the article.

b2

Press PAGE UP and PAGE DOWN to move up or down a screen.

Press the ESC key to close a dialog box.

Finding Words in the Text
Use Find Word on the Search Menu to find a word in the text of an article.

Moving From Article to Article
1 Use Cross References to jump to articles whose titles are mentioned in the text.

2 Use the Last Article Button or choose Previous on the Article Menu to
move back to a previously viewed article. Choose History on the Article
Menu to view a list of all articles viewed in the current session.




Contents

The Contents Menu lists all the headings and all the multimedia items contained in the current article. To
display the Contents, click the Article Contents Button. All the article subheadings and all the multimedia
items will be listed in a floating menu.

To Move to a Topic Heading in the Article
Choose a subheading from the list and click the mouse button or press Enter to go to that section of the
text.

L
To Move to a Multimedia Item in the Article

Click one of the multimedia items (marked with the appropriate symbols) in
the list or highlight the item by moving the cursor and press Enter to launch
the viewer.



Articles and Subjects

Articles

Click on the Titles Button on the Encyclopedia Screen to display an alphabetical list of articles in the
pncyclopedias.

Subjects
Click on the Subjects Button to display the subject index.

& The articles in The Canadian Encyclopedia are marked with a maple leaf,
those of Columbia with a world icon and those of Maclean's with an M. Choose
Canadian from the Search menu to view the entries from The Canadian
Encyclopedia and Maclean's only. Choose Canadian & Columbia to view a list
of entries from both encyclopedias and Maclean's.

E] How To:
How Do | Find Article Titles?




Optimizing Multimedia Performance

In order to get the best performance of the multimedia elements of the encyclopedia, you should ensure
that your hardware and software have been set up properly.

>

Audio

The audio selections work best with a 16-bit sound card. Not all of the sounds will play on an 8-bit sound
card. If you have a sound card installed but still cannot hear the sounds, check to make sure that the
proper drivers are installed. Consult your Windows or Macintosh manual for instructions on installing
drivers.

Video and Animation
Videos and animations will work smoothly only if QuickTime has been correctly installed during
installation. The speed and smoothness of the video depend on the speed of your processor, the quality
of your video card and the amount of RAM available.
& The Canadian Encyclopedia Plus utilizes QuickTime 2.1.0.41 (Windows 3.1)
or 2.1.0.42 (Windows 95). If these files are overwritten by an earlier version
of QuickTime, the videos and QuickTime VRs in this program will not play.

Pictures
Pictures are optimized for 256 colours. Make sure that the proper 256-colour video drivers are installed on
your computer. The pictures will show on a 16-colour display but will be of poor quality.

Because of the compression used on this disk, the pictures will not display

on less than a 486DX computer in Windows.



Viewing and Navigating the Multimedia

Where multimedia items in The Canadian Encyclopedia Plus appear

1 As titles in the search results from SmartSearch, Search or from searches in the Multimedia Browser
(see Searching the Multimedia).

2 As Thumbnails in the text of articles.

3 As Thumbnails in the Timeline.

How multimedia items are viewed
1 By double clicking on a thumbnail.
2 By double clicking on a multimedia title in the Multimedia Browser or in a search list.

Pictures

To view a picture, double click on its title in a results list (or click the View button) or double click a
thumbnail displayed in the text.

<)
Sounds

To play a sound, double click on its title in a results list or double click a thumbnail displayed in the text.
Then click the Sound Button to listen to the sound.

Videos or Animations
To play a video or animation, double click the title with the mouse or select the title and click the View
button.

VR

QuickTime VR
QuickTime VR are special pictures that enable a viewer to move through a panorama and to zoom in or
zoom out of a scene.

Hypergraphics

Hypergraphics allow the user to click on a "hot" spot on a picture and zoom to a related subject or to a
detail of the current subject, much as Cross References allow the linking of articles.

Click on the following to get pop-up help on the Multimedia Browser, the Picture Viewer and the Video
Player:

Multimedia Browse Screen Hypergraphic
Video Player

Picture Viewer




Going to an Article from the Browser

I o to article

Click the Go to Article button on the Multimedia Browser Bar to bring up the text of an article. If more than
one article is associated with a multimedia item, a dialog box offers a list from which to choose.



Filters

Use Filters to include or to exclude types of multimedia in the Browser. For example, show only the
Videos by clicking the Video icon. Show only Sounds and Videos by clicking on the Sounds and Video
icons.




Slide Show

Starting the Slide Show
I slide show | |
Click the Slide Show button on the Multimedia Browser to run a slide show of pictures from the
encyclopedia.

Set the delay between pictures in Preferences

Running the Slide Show
Click Pause to pause the show (or the Continue button to continue after a pause) and the Stop Slide
Show Button to quit the slide show and return to the Browser. To go to the article associated with a
picture, click the Go To Article button.

& The pictures in the slide show display in the order that they appear in the
media index. The filters and subject categories still work in slide show. For
example, if you choose the media subject Arts/Painting, the slide show will
only include items in the painting category. If you choose the subject All and
the filter Graphs, slide show will show only graphs and no other media.



Viewing Multimedia from the Encyclopedia Window

All multimedia elements appear in the text of articles as thumbnails (if this option has been chosen in
Preferences). When you pass the mouse pointer over the thumbnails, the pointer changes to indicate the
type of media. In the example below, the pointer indicates that the item is a photograph.

When viewing an article with multimedia, double click the thumbnail to expand the picture or to launch the
video player. (In the text of articles, sounds do not appear as separate multimedia items as they do on the
Multimedia Browser. In articles, all sounds are associated with pictures. Bring up the picture and click the
sound button.)



Quiz

Starting the Quiz
o

Launch the encyclopedia quiz by clicking the Quiz Button on the Encyclopedia Screen.

& The Quiz is available in both English and French. Choose French or English
on the Question Menu in the Quiz Screen. The questions are identical.

Answering a Question
Answer a question by choosing the appropriate letter button below the question or next to an illustration. If
the answer is correct, it is registered on the scoreboard, and a piece of the puzzle appears. Click the New
Question button to display another question.

Getting a Clue
If you do not know the answer or want to find out more about the subject of the question, click the Clue
Button to go to a relevant encyclopedia article. (Click the Quiz Button to return to the question.)

Solving the Puzzle
When you have completed the quiz, you can try to solve the puzzle by moving the pieces with the mouse.
The puzzle is similar to the small games with push tablets familiar to most children. Click the Hint button
to move one piece or the Solve button to solve the entire puzzle. The Scramble button rescrambles the
puzzle.

Options
The Puzzle menu allows you to turn the sound on or off, remove the numbers from the puzzle pieces or to
insert a new picture as the puzzle.

Click here to view the Quiz Screen.



Abbreviations






Amateur Athletic Association



Admiral



Also known as



Alabama



altitude



Alberta



approximately



April



Alberta Research Council



Arizona



Arkansas



Association



Assistant



Attorney General



August



Bay



born



Bachelor of Arts



baptized



British Broadcasting Corporation



British Columbia



Bachelor of Commerce



boundary



Bachelor of Education



Bachelor of Literature



Boulevard



Bachelor of Music



British North America



Borough



Brigadier-General



Bachelor of Science



Bachelor of Social Work



British Thermal Unit, the amount of heat required to raise the temperature of one pound of water one
degree Fahrenheit at 39.2°F



bushel, unit of dry measure, equal to 4 pecks, or about 35.2 litres
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City



census






Census Adjusted



Chartered Accountant



Canadian Armed Forces; Canadian Air Force



California



Captain



Canadian Association of University Teachers



Canadian Broadcasting Corporation



Companion of the Order of the British Empire



Co-operative Commonwealth Federation



Canadian Congress of Labour



Commander



Canadian Expeditionary Force



Collége d'enseignement général et professionel



Canadian Forces Base



Canadian Film Development Corporation



Canadian Football League



Certified General Accountant



Channel



centimetre, a unit of length equal to 1/100 of a metre or 0.3937 inch



Census Metropolitan Area



Companion of the Order of St Michael and St George



Canadian National Railways



Confederation of National Trade Unions



Company



Colonel



College



Colorado



Community



Connecticut



Constable



Corporation



Canadian Officer Training Corps



Corporal



Canadian Pacific Railway



Canadian Radio Broadcasting Commission



Canadian Radio-Television and Telecommunications Commission



Canadian Transport Commission



Czechoslovakia



County






Died



Dakota



Danish



decibel, a unit used to express relative difference in power, usually between acoustic or electric signals,
equal to ten times the common logarithm of the ratio of the two levels



December



Delaware



Denmark



Department



Distant Early Warning



Distinguished Flying Cross



Department of Indian Affairs and Northern Development



Director



District



Division



District Municipality



Doctor of Music



Distinguished Service Cross



Distinguished Service Order



Doctor of Social Work



deadweight, the weight of an inert mass



East



Estimate



Editor, edited by, edition



European Economic Community



(exempli gratia) for example



Elevation, height above the level of the sea



Department of Energy, Mines and Resources



England



Established



(et alii) and others




(et cetera) and so forth
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Florida



Flying Officer



Founded



February



folios, a leaf of a manuscript or book, a page number



(floriat) flourished




Flight Lieutenant



Flight Officer



Flight Sergeant



Father



Friday



Fellow of the Royal Society of Canada



Fort



Gram, a metric unit of mass and weight, equal to one-thousandth of a kilogram



Georgia



General Agreement on Tariffs and Trade



Gross Domestic Product



General



Germany



gigahertz, one billion hertz



Greek



Gross National Product



Governor General



Government



Geological Survey of Canada



Gigawatt, one billion watts
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Hour



Hectare, a metric unit of area equal to 100 acres or 2.471 acres



Hamlet



Hudson's Bay Company



Hectolitre, a metric unit of capacity or volume equal to 100 litres in liquid measure (or 105.7 liquid quarts)
and a metric unit of capacity or volume equal to 100 litres or 90.8 dry quarts in dry measure



hectometre, a metric unit of measure equal to 100 metres



Her Majesty's Canadian Ship



horsepower, a unit of power equal to 745.7 watts or 33 000 foot-pounds per minute



Hour



hertz, a unit of frequency equal to one cycle per second



Island, Islands



(id est) that is




lllinois



Incorporated



Indiana



Inspector



Institute, Institution



International



Introduction



Indian Reserve



Ireland



January



Kilo, Kilogram, a basic measure of mass and weight in the metric system, equal to the weight of a
platinum and iridium cylinder kept at the International Bureau of Weights and Measures, near Paris; equal
to about 2.2046 pounds



Kansas



Knight of the Bath



King's Counsel



Knight Commander of St Michael and St George



Kilogram, the fundamental unit of mass in the International System, equal to the weight of a platinum and
iridium cylinder kept at the International Bureau of Weights and Measures, near Paris; equal to about
2.2046 pounds



Kilohertz, one thousand hertz



Kilolitre, one thousand litres



Kilometre, one thousand metres



kilometres per hour



kilopascal



Kilowatt, one thousand watts



Kilowatt hour



Kentucky



Litre, a metric unit of volume equal to a cubic decimetre, approximately 1.056 liquid quarts or 0.908 dry
quart



Louisiana



Labrador



Latin



Latitude



Lower Canada



Local Improvement District



Doctor of Laws



Lake, Lakes



Longitude



Lieutenant-Governor



Limited



Limitée
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Metre, the basic metric unit of length, defined as one ten-millionth of the distance on the Earth's surface
from the pole to the Equator.



Metres per Second



Master of Arts



Major



Manitoba



March



Massachusetts



Member of the Order of the British Empire



Maryland



Doctor of Medicine



Maine



Master of Engineering



Milligram, one-thousandth of one gram



Monseigneur



Megahertz, unit of frequency equal to one million hertz



Michigan



Military Reserve



Minute



Minnesota



Mississippi



megajoule, unit of energy equal to one million joules



millilitre, one thousandth of one litre



Member of the Legislative Assembly



millimetre, one thousandth of one metre



Member of the National Assembly



Missouri



Montana



Member of Parliament



Master of Science



Master of Social Work



Mount



Mountain, Mountains



Mount Allison University



Megawatt, one million watts
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North



North Dakota



New Mexico



National Archives of Canada



New Brunswick



North Carolina



No Date



National Defence Headquarters



New Democratic Party



National Energy Board



Nebraska



National Energy Policy



Nevada



National Film Board



Newfoundland



New Hampshire



National Hockey League



New Jersey



Number



Norway



North American Air Defence



November



National Research Council



Nova Scotia



Nova Scotia College of Art and Design



Nova Scotia Agricultural College



National Topographic Survey



North West Company



Northwest Territories



New York



Ontario College of Art



Order of the British Empire



October



Organization for Economic Co-operation and Development



Oklahoma



Oblates of Mary Immaculate



Ontario



Organization of Petroleum Exporting Countries



Oregon
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Pennsylvania



Public Archives of Canada (now National Archives of Canada)



Progressive Conservative; Progressive Conservative Party



Privy Council Office



Prince Edward Island



Peninsula



Hydrogen-ion Concentration



Doctor of Philosophy



Prime Minister



Prime Minister's Office



Post Office, Petty Officer



Population



Prisoner of War



Parti Québécois



Premier



President



Pseudonym



Point



Published



Queen's Council



Quebec



Abbreviations R-S




River



Research and Development



Royal Air Force



Royal Canadian Air Force



Royal Canadian Navy



Rural District



Rear-Admiral



Regiment



Reprinted



Revised



Royal Flying Corps



Rhode Island



Rural Municipality



Royal Military College of Canada



Registered Nurse



Royal Society of Canada



Railway



South



Second



South Dakota



Saskatchewan



South Carolina



Scotland



Senator



September



Simon Fraser University



Sergeant



Systéme International des Unités



Society of Jesus



Society



Solicitor General



Spanish



Squadron Commander



Squadron Leader



Ship Title, steamship



Saint



Sainte



Strait



Superintendent



Switzerland
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Town



Tonne, metric ton, 1 million grams



Trans-Canada Airlines



Tennessee



Territory



Texas



Trades and Labor Congress



Translated



Television



terawatt hours, a trillion hours



Township



University



Université de Montréal



University of Lethbridge



University of Manitoba



University of Alberta



University of Calgary



University of Ottawa



University of Toronto



University of Victoria



University of Winnipeg



University of British Columbia



Upper Canada



University College of Cape Breton



United Kingdom



United Nations



University of New Brunswick



United Nations Educational, Scientific and Cultural Organization



Unpublished



Unincorporated Place



University of Prince Edward Island



Université du Québec



Université du Québec a Chicoutimi



Université du Québec a Montréal



Université du Québec a Rimouski



Université du Québec a Trois-Riviéres



United States of America



Union of Soviet Socialist Republics



Virginia



Village



Volume



Vice-President



Vermont



West



Washington



Wisconsin



Wilfrid Laurier University



Warrant Officer



World War One



World War Two



Wyoming



Young Men's Christian Association



Yukon Territory



Young Women's Christian Association



Buttons



Anagram Button

| | Definition

search | Anagram | and |

The Anagram Button is located in the Dictionary Window. Click the button with
the mouse to find words containing the same letters as the current word.



Titles Button

b

The Titles Button is located on the Encyclopedia Screen. Click this button
to display the lists of titles in the encyclopedias.



Last Article Button

Use the Last Article Button (located on the menu bar of the Encyclopedia screen) to move
back through the articles you have viewed in this session. The list of articles recently
viewed can be seen by choosing "History" from the nearby Article menu in the
Encyclopedia Window.



Close Button

The Close Button E closes the current window. The Close Button on the upper right-
hand corner of the Encyclopedia Screen closes the program.



Definition Button

Click this button in the Dictionary to find a dictionary or thesaurus entry on the term entered
in the search box.

| | pefinition

Search I Anagram I : I




Dictionary Button

The Dictionary Button is located on the lower right of all screens. Click
this button to open the dictionary. In the Encyclopedia Window activate
the dictionary by double clicking a word.



Help Button
The Help Button is appears on the upper right of the Encyclopedia and
Dictionary screens as a large question mark. Click this button to launch the
on-line help.



View Button

Click this button to view the currently selected article in a list of titles or to see a list of all
article titles in the currently selected subject in the Subject List window.



Searching the Encyclopedia Texts

The Canadian Encyclopedia Plus provides the user with several powerful tools for searching the text of
the encyclopedias.

The text search procedures are activated by the two buttons in the upper right of the Encyclopedia
screen.

1 Boolean Search
Use Boolean search to perform simple word searches or traditional Boolean searches. Boolean Search
also provides more advanced features and spell checking.
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More detailed instructions are provided in Boolean Search.

2 SmartSearch

Use SmartSearch to perform more general searches. While Boolean Search is appropriate for specific
searches related to known names and terms, SmartSearch is designed to search for concepts, ideas and
the relationships between words.

More detailed instructions are provided in SmartSearch.



SmartSearch

Use SmartSearch for broader, more suggestive searches of the entire text of the encyclopedia, beyond
simple requests for a term, name or place.

Using SmartSearch to Find Single Words
Click the SmartSearch Button on the upper left of the Encyclopedia Screen.

2 Type your word in the entry box and click the Begin Search button or Press Enter.

Searching for a single word in SmartSearch gives you a results list that differs from such a search in
Boolean Search. The results are not listed in alphabetical order but in the order that reflects the frequency
or weight of your term.

Using SmartSearch to Find Phrases

1 Type a phrase referring to differing aspects of your query.
The phrase may be in the form of a question, such as "Why do leaves turn colour in autumn?" or
"Who invented the G suit?" The latter turns up the inventor Wilbur Franks first in the list and a
picture of Franks and his suit.

SmartSearch Results
1 SmartSearch provides a results list in which terms of a phrase or group of words have been weighted
according to various criteria, such as frequency, proximity and related terms.
2 The titles in the Results list are ranked in an order reflecting the likelihood that the articles answer the
query.
Thus if you type the query "Who was Yonge Street named for?" the entry Toronto appears at the
top of the list.
3 When you preview (by clicking the Preview Button) one of the articles in the SmartSearch results list,
the viewer takes you automatically to the part of the article that is most likely to satisfy your query.
4 SmartSearch results lists include relevant multimedia items, as the above example included a
photograph of Yonge Street.

L
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Because few questions have simple or obvious answers, beyond simple questions of fact, the list will not
always be ordered in a predictable manner. The purpose of SmartSearch is to find and suggest
relationships that may not have occurred to the user as well as the kind of specific results provided by
Boolean Search.

5 The program offers a way to further refine your search with the Tuner.



Bookmarks

Bookmarks allow you to collect and organize materials from the encyclopedia into a Bookmark List. Use
Bookmarks for making notes, attaching notes to articles and marking lists of articles and pictures.

Creating a New Bookmark List
Use the Bookmark Button to create a new Bookmark List.

e
Step-by-Step Instructions.

The following graphic shows the various functions available on the Bookmarks List window. Click on the
various items for explanations.

untitled




The Title Index

The Title Index contains a complete alphabetical listing of all the article titles in the encyclopedias.
To search through the alphabetical list of article titles:

&

1 Click the Titles Button
The Titles Button is located on the upper left of the Encyclopedia Screen.

2 Type your term into the Titles search box
As you type the list moves automatically to the closest matching title in the encyclopedia.

3 If you cannot find what you are looking for
Click the QuickSearch Button to the right of the Title box. Find will search for titles that contain

your term. Example.

4 To View an Article
Double click on a title or press Enter to view the text of an article.

&



Spelling Check

Spell check is available in Boolean Search and in SmartSearch.
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To check the spelling of your search terms in the Search Window:

1 In the Boolean Search or SmartSearch window, toggle the Spelling Button to read "Spelling On."
(Toggle to "Spelling Off" to turn off this feature.)
2 If one of the terms that you have entered in the search box is not found, Boolean Search or
SmartSearch offer a list of alternative spellings.
For example, you may be looking for the article on the governor of New France and type
Vaudriel. Boolean Search or SmartSearch suggests Vaudreuil.
3 Choose Change in order to change the search term to the term selected in the list box.
Choose Ignore to proceed with the search without changing the spelling of the current term,
Ignore All to proceed without changing the spelling of any of the search terms, and choose
Cancel to stop the search altogether.



Subject Index

Use the Subject Index to find articles in the encyclopedias that are related to one another under common
subject headings.

Many of the main subject headings lead to as many as 6 levels. Example

To Find a Subject Heading
1 Click the Subjects Button on the upper left of the Encyclopedia Screen.

&

= W subjects

2 Choose whether you wish to Browse the subject tree or to Search the subject list by clicking the
appropriate button.

to Browse the list

to Search the list

L

Click here for step by step instructions on How to Browse the Subject List

Click here for step by step instructions on How to Search the Subject List

L

Click here to see the Search Subjects Screen.

- You can display the articles in the same subject category as the current article by
clicking the More in Subject Button at the bottom of the article.




Not

Use the "NOT" operator (!) to restrict your search of multiple terms by excluding certain items.
For example, you may want to find all the references to sports (271 results in The Canadian
Encyclopedia), but not hockey or baseball (254 results). To perform this search, type sports in the
first text box, click the NOT button after the term, type the word hockey, and then repeat the
process for baseball. Your search would look like the following in the advanced window:

® sports NOT hockey NOT baseball

Proceed with the search to see all the records which contain the word sports but do not contain the words

hockey or baseball.



Or

Use the "OR" operator (|)to find articles that contain any one or any combination of your terms; hence the
search fish OR birds OR mammals turns up 714 results in The Canadian Encyclopedia, when such a

search using AND gives only 30 results.

Click the Or button after each of your terms or type the word OR (in capital letters) after each term in the
advanced window.
Use OR to search for variations of spelling or for plurals of the same word; for example,
Parliament OR parliaments OR Parliamentary, or for words and their abbreviations. For example,
you might look for Ontario OR Ont OR Ont. (with a period).



And

Use the AND operator (&) to find only those articles that contain every word in your search.
For example, if you enter the words fish AND birds AND mammals, you will turn up every article
that contains all these words together in the same article. An article with just the word "fish" would
not satisfy this search. (You can use the ampersand symbol & in place of the word AND in the

advanced window.)



ASCII Text
ASCII stands for American Standard Code for Information Interchange. It is the standard format for
exchanging electronic information.



Generic Word Processor Format
Generic Word Processor is a format that can easily be used by all word processors. In this format, the
hard returns at the end of each line will be converted to spaces.



Cross References

Cross References are pointers to other articles in the encyclopedia which contain information related to
the current article. They are directly linked to the articles of the same name.

Appearance
Cross references appear underlined, in capital letters and by default are coloured dark green. (You can
change the colour on the Preference dialog box. See Preferences.)

To activate a Cross Reference
Place the mouse pointer over the cross reference. The pointer turns to a large vertical arrow.
Click the reference once with the mouse.
You are transferred directly to the new article.
To return to the original article, click the Last Article Button on the tool bar.

BON-=




Boolean

A Boolean Search is a complex search using operators such as "AND" (&), "OR" (]), "NOT" (!) and NEAR

(~). It is named for the algebraic system developed by the English mathematician George Boole.
Boolean operators allow you to define relationships between the terms in your search.



Dictionary

The Canadian Encyclopedia+ contains two complete dictionaries, the English only Gage Canadian
Dictionary and a full-featured bilingual dictionary which translates from French to English and English to
French as well as conjugates French verbs. A thesaurus provides English synonyms.

There are several ways to open the dictionaries

e

Click the Dictionary Button on the Encyclopedia or Timeline screen.

e

Choose Dictionary from the Navigation Menu.

Double click on a word in the text of any encyclopedia (or dictionary) entry. A search for your word is
begun automatically.

& The auto-search function of the dictionary defaults to the last dictionary used in
the current session; i.e., if you last used the French-English dictionary and
double click a word in the encyclopedia, the word will be looked up in the
French-English dictionary.

Click Here to view the Dictionary Screen

L



Finding a Definition in the Dictionary
To find a definition in the Dictionary

1 Open the Dictionary by clicking the Dictionary Button on the lower right of any screen.
2 Using the buttons on the upper left,

e
Click the Dictionary Button to look up a word in English
Click the French-English Button to find an English translation of a French word

Click the English French Button to find a French translation of an English word

e
Click Thesaurus to find synonyms for an English word
& To activate the English dictionary and the Thesaurus at the same time,
choose Dictionary & Thesaurus from the Dictionary Menu.
e

Enter the term in the Search Word or Expression entry box of the Dictionary Window (or double click a
word in the text of an article).

3 Press Enter or click the Definition Button (or Translation Button if you are using the bilingual dictionary)
to find the definition.

4 If no word is found, a dialog box prompts you to choose an alternative spelling from the Spelling
Alternative list.

5 Choose one of the alternative spellings and click the Definition (or Translation) button.

e

Click here for pop-up help with the Dictionary

Click here for help with entering Accents in your search.

Click here for help with the Erench-English Dictionary.



Searching for Terms in the Dictionary

While the Definition Button looks for a separate definition for your term, Search finds that term no matter
where it appears in the dictionary.
To search for a term in the entire dictionary

1 Type a term, for example rodent, into the Search box of the Dictionary Window.

2 Click the Search button under the search entry box.

3 The Search Results screen lists the entry Rodent along with all other entries that include the word
rodent.

4 Move to another definition by double clicking a word in the Results list, for example, muskrat.

&



Boolean Searches in the Dictionary

Use Boolean operators to broaden or to narrow your searches in The Gage Canadian Dictionary or the
bilingual dictionary.

The And Operator
Use the AND operator to find only those dictionary entries that contain all your terms.

1 Type the first term, then the word AND (it must be in capital letters) and then your next term. For
example, type woodsman AND fur.
2 Click the Search button to generate a list.
3 Choose a word from the Results list and double click, or click the Definition Button.
& Use the AND search to find words where you know that a term exists and
know other words that describe it. In the above example, the word coureur
de bois was found.

The OR Operator
Look for entries containing any of your terms using the OR operator; for example type fish OR fowl. Click
the Search button. (Generating a list including bluefish and chicken.)
Use the OR search to find words and variations of words. For example, if
you type rodent and click Search you get 9 results. If you type rodent OR
rodents you get 32 results.

The NOT Operator
Narrow your search using the NOT operator, for example, type forage NOT hay. Click the Search Button.

(Achieving a list including barley and soybean.)



Anagrams

Anagrams are words formed by reordering the letters of another word. A single word or phrase may yield
many anagrams or none. To find anagrams

1 Open the Dictionary by clicking the Dictionary button in any screen.

2 Click the Dictionary Button and enter a word or phrase into the search box.

3 Set the Options for the minimum number of letters required for an anagram in the Options menu.
(For example, enter a length of 8 for the word broadcasting and get over 20 anagrams. Set it to 9
and get only 9 anagrams.)

4 Click the Anagram Button.

b



Using Wildcards in the Dictionary

Wildcard characters can be used in dictionary searches to represent unknown letters or sequences of
letters. There are two wildcard characters: ? and *.

1 Use a question mark (?) to stand for a single unknown character. For example, typing f?rmer gives
the results farmer, firmer and former.

2 Use an asterisk (*) to stand for an indefinite number of characters. For example, type hon’r to find all
words beginning with "hon" and ending in "r," such as honeymooner and honour, or voyag®r to find the
word voyageur.

3 Enter your word or phrase, including wildcards, in the Search box and then click the Wildcard Button.
(The button lights up only when you enter a wildcard.)

4 Choose a word from the Wildcard list by double clicking the word or by highlighting the word and
pressing Enter.



Garbage Button
Use this button in Bookmark List Mode to delete an item from your Bookmark List. Select the item and
click the button.



Example: No Match

For example, if you type Donavan Bailey, looking for the runner, spellcheck finds 3 alternatives for the
mispelling, one of which is Donovan. Highlight Donovan and click the Change Button to complete the

search. Click the Ignore (or Ignore All) Button to proceed with the original search or Cancel to stop the
search. A dialog box informs you if no match is found.



Example: QuickSearch
For example, if you type the word information, you are taken automatically to the first article that begins
with that word, Information Highway. If you click QuickSearch, you are presented with a list of all the
articles containing your search term. Click on one of these titles to display the article.
This procedure is very helpful in finding people with complex names or titles; for example, if you
type the name Beaverbrook and then click QuickSearch, the Results screen shows the article
Aitken, William Maxwell, 1st Baron Beaverbrook. If you know a first name, for example Margaret,
click QuickSearch will display a list of all the titles containing Margaret.



Example: Subject Levels
For example, to find the premiers of Manitoba,

&

Click the & sign next to the primary subject heading SOCIAL SCIENCES

&

Scroll down to find the sub-heading Politics & Government, click

then click Government,

®

then click Biographies,

@

then click Canadian Premiers

@

then click choose Manitoba.

@

Press Enter or click view to see the titles.



Combined Searches Using Boolean Operators

You can perform complex searches which combine the AND, OR and NOT operators, for example the
following:
bank or club not Canada
The results will include every article that contains either the word bank or the word club but not the word
Canada.
& If you use multiple search operators, they are processed in order of precedence
and then from first to last. AND and NOT have equal precedence over OR.



Keyboard Commands

Some useful keyboard commands:

Windows Macintosh Function

HOME HOME Move to the beginning of an article

END END Move to the end of an article

PAGE-UP PAGE-UP Move to the previous screen

PAGE DOWN PAGE DOWN Move to the next screen

TAB TAB Move to the next field of control

ENTER ENTER Activate the current function

DELETE DELETE Delete the current character; delete the current selection

ESC ESC Cancel the current function or screen. Exit (from Home Screen)
ALT+F4 Command + Q Close the current Window or, in the Home Screen, exit the program
CTRL+C Command + C Copy selected text to the Clipboard

SHIFT+V Command +V Paste text from the Clipboard

CTRL+P Command + P Print Article or Print Dictionary

CTRL+S Command + S Save Article (Encyclopedia mode) or Entry (Dictionary)

Finding Related Articles

To perform a SmartSearch using all the words of the current article:

L

Click the Related Button in the upper right of the Encyclopedia Screen.
The Search Results will list the article titles in the order of the likelihood that they will match the
words in the current article.

b2

The results list from a Related Search will include Cross References from the current article as well as
related media titles. If you select text and click the Related Button, a search will be run only on your
selected text and will not include the cross references.

L



Selecting Text

Select text by clicking and dragging with the mouse button pressed. (Use the left mouse button in
Windows). Make multiple selections by holding down the Crtl key (Windows) or Command key
(Macintosh) while dragging the mouse over a new location.

Select text in order to perform one of the following tasks:

Instant Search
Run a SmartSearch on selected text by selecting the words and clicking the Related button. The search
for related articles based on your selected text proceeds automatically.
last articla [+ article contants W |} Related

Harris, Lawren Stewart

Saving, Printing, Copying

e
Select Text and Save it, Print it or Copy it to the clipboard.
& Select Text for a Dictionary Search by double clicking on any word in the
encyclopedia or dictionary. The Dictionary Window is automatically invoked.
Clearing Selected Text
e

Clear Selected text from an article by clicking the mouse.

&



Highlighting Text

Highlighting is the equivalent of marking printed text with a yellow highlighter.
birthrate fihe annual number of lee births per 1000

infrabitants) was 201, Im & gconomic conditions caused

a recovery that acceleratedduning WWIL By 1245 the

birthrate frad risen to 24.3 per 1000 inhabitants; by 15465 i

had jumped te 27 2 per 1000 inkabitants, and it resrained

batwaen 27 and 265 per 1000 untif 1952, after which time it

gradually fall.

To highlight text,
Mark the article so that it will be included in a Bookmark List.

2 Click the Highlighting Tool m
3 Drag the Highlighting Tool (holding the mouse button down) over the text to highlight the text.

To clear highlighted text
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Clear Selected text from an article by choosing "Clear Highlights..." from the Bookmarks Menu while in
the Encyclopedia screen or by using the same mouse action that was used to highlight the text.

L




Changing the Path in Save

1 (Windows only) Change the drive by double clicking on a drive letter (for example, C:) in the drive
box.

2 List all the directories on a drive by clicking on the drive letter in the directories box.

3 Double click a directory and it will appear automatically as your path next to the heading. The new
path will be kept in memory for the current session, unless you change it.



Preferences ...
Choose this menu item to open the Preferences window.

For More Detailed Information:
[] Preferences



Save Article ...
Choose this menu item to save the current article or selected text. This function can also be activated by
pressing CTRL+S.

For More Detailed Information:
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Saving



Copy Selected Text...
Choose this menu item to copy selected text to the Windows clipboard. The command is also activated by
the keyboard shortcut CTRL + INSERT (Windows) and Command+C (Macintosh).

For More Detailed Information:

b

Copying



Clear Selected Text

Choose this menu item to clear all selected text in the current article. The command is inactive if no text
has been selected.

For More Detailed Information:
[J Selecting Text



Clear Highlights

Choose this menu item to clear all highlights from the current article. The command is inactive if no text
has been highlighted.

For More Detailed Information:
[1 Highlighting Text



Home Screen
Choose this menu item to return to the Home Screen.



Contents
Choose this menu item to go to the Help Table of Contents.



Search for Help On
Choose this menu item to search for specific Help topics.



How to Use Help
Choose this menu item to find help on using Windows Help.



About The Canadian Encyclopedia
Choose this menu item to display information on The Canadian Encyclopedia Plus.



Locating Text in an Article

To Search for any term or terms in the text of the Current Article.
Choose Find Word in the Search Menu to open the Word Find window.
ch

Find "Ward

Enter your term or terms in the Word Find entry box.

Enter word{s) that you wish to find
within the current article. Use the
small scrofl arrows to find the next case
of the word within the article.

Locate:
telescopic|
X| Match case
| Match whole word only

3 Click the Begin Search Button at the bottom of the window.
4 Click the Box Icon & on the scroll bar to go to the next match for the term.

Match Whole Word
Select "Match Whole Word Only" to match all the letters of your search term; for example, with this option
selected the search item visitor would not find the word visitors. With this option not selected, the search
expression visit would locate the words visit, visitor, visitation, etc.

Match Case
Select "Match Case" to find terms that match the case of your search item; for example, to find Floral and
ignore floral, type the expression Floral and choose Match Case.



Article Title
The article title appears as it does in the alphabetical listing of the Title Index.



Cross References

Cross References are pointers to other articles in the encyclopedia which contain information related to
the current article. Cross references appear underlined, in capital letters and in a different colour from
normal text (set in Preferences). To activate a cross reference, place the mouse pointer over the cross
reference and click.



Backtrack
The Backtrack Button displays the last article that you viewed. Move back one title at a time in the reverse
order in which you have viewed them.



Related Button
Click the Related Button to perform a SmartSearch using all the words of the current article as search
terms.



Scroll Bar
To move through the text using the scroll bar:

&

Click on the solid scroll arrows & to move up or down one line at a time

L

Click on the open scroll arrows & to move up or down to the next match in your search terms

L

Drag the scroll box & up and down to a new position in the text



Bookmark List Notes
Bookmark List Notes contains your free-form notes on the current Bookmark List. To add a note

e

Click on the Bookmark Button to display the Bookmarks List window.

Double click on the List Notes Button and add your note.

b2

To print the note, click the Print Note Button

b2

To delete the note, click the Erase Note Button.



Titles List
The list of titles that match the current search procedure are in alphabetical order except in SmartSearch,
in which case they are in order of the likelihood that they have matched the pattern of the search terms.



Search Term
The search term or terms appear in a different colour in the text. (Colours can be changed in
Preferences.)



Help Button
Click the Help Button for help on the current topic.



Continue Button
Click the Continue button to change the term to the term selected in the list box.



Ignore Button

Click the Ignore Button to proceed with the search without changing the
spelling of the current term. Click Ignore All to proceed without changing
the spelling of any of the search terms.



Thumbnail

[
B,

A thumbnail is a small graphical representation of a multimedia item located in the text of the
encyclopedia. Double click on the thumbnail to display the picture at its full size or to launch the video
player.



Multimedia Icons
These symbols indicate the type of multimedia object:

Graph
Hypergraphic

Map

*®BE E

Picture

Table

@

Video



Browser Filter Button

Click the Filter button to bring up the Multimedia Filter. Use the Filter to display all or only some types of
multimedia items.



Slide Show Button

Click the Slide Show button to activate the slide show of pictures chosen randomly from the encyclopedia.



Viewer Picture Area

The picture is displayed at its full size in this area. If the entire picture does not fit, use the scroll bar to
move the picture up.



Viewer Caption Button

Click this button to display the caption for the current picture. Use the scroll bar to display the caption if it
is too long to fit into the caption area.



Viewer Sound Button

A sound button signifies that a sound is associated with the current picture on view. Click the button to
play the sound.



Viewer Next and Previous Button

Click the Next (forward pointing) button to view the next picture in the currently chosen subject and the
Previous button to view the previous picture in the list.



Viewer Pause Button

Use this button to pause the slide show.



Viewer Slide Show Button

Use this button to begin a random slide show of pictures in the current subject area.



Video Player Title

This area displays the title of the current video or animation.



Video Play Area

The video displays in this area when the play button is clicked. When the video is paused, a single frame
is displayed.



Video Play Button

Click this button to play the video or animation. When the video is playing this button changes to a pause
button.



Video Scroll Button

Use the Video Scroll button to move the video or animation to a specific place.



Video Reverse Button

Use this button to move the video frame by frame in reverse.



Forward and Reverse Buttons

Use these buttons to move forwards or backwards through the multimedia list from the point of the current
object.



Video Print Button

Use the Print button on the Video player to print the current frame while in pause mode.



Video Go To Button

Use the Go To button to go to the article with which the current video is associated. If there is more than
one article, a dialog box presents a list from which to choose.



Video Player Close Button

Use this button to close the Video Player.



Video Player Print Button

Use this button to print a frame of the current video. (Pause the video first.)



Video Player Caption Button

Use this button to display the caption for the current video.



Video Player Pause Button

Use this button to pause the current video. Click play to resume.



Multimedia Browser Window

Point to an area of the screen. The mouse pointer turns to a pointing hand where pop-up help is available.

media browser 528 itern(s) )| media by subject x|
| €| || stide show p || b ||addigp| ¥ All
[Abalone | I Animals o
Arts
IQHinkSHan:hTI I media by subject 4 I Coins, Stamps, Emblems
= Abalone =l |» Geography
&= Albertosaurus = History
&= Alderfly P Huran Activities
[&= American Avocet Mative People
&= Ants P Plants
&= Aphid b Paortraits
[d= Arctic Fox Science and Technology
[&= Arctic Ground Souirrel Statistics
[#= Arctic Ground Soquirrel, Stand
[&= Arctic Hare
[&p Arctic Woalf
[d= Arctic Walf, Frant Wiew b
]
Click here to view the_Picture Viewer
@

Click here to view the Video Player



Video Player

The Video Player is activated when you double click on a video or animation title or thumbnail. The video

or animation will begin to play automatically. Click on the controls on the screen below for further
explanation.




Picture Viewer

Point to an area of the screen. The mouse pointer turns to a pointing hand where pop-up help is available.




Viewer Close Button

Use this button to close the viewer.



Viewer Go To Button

Use the Go To Button to go to the text of the article with which the multimedia item is associated.



Viewer Print Button

Click this button to print the picture showing in the Viewer.



Saving and Copying Definitions

Saving Definitions

To save a definition from the dictionary, choose Save Entry (Ctl + S) from the Edit menu in the Dictionary
Window. Name the entry and click OK.

Copying Definitions
To copy a definition from the dictionary, choose Copy Entry (Ctl + C) from the Edit menu in the Dictionary

Window. To insert the definition into a note or document in another program, press SHIFT+INSERT
(Windows) or Command+V (Macintosh).



Article Text

The style and size of the text fonts can be adjusted through the Preferences window accessed through
the File Menu in Encyclopedia view. When you perform a search, the words matching your search terms
are highlighted throughout the current article.

To move through the text of an article using the scroll bar:

e

Click on the scroll arrows to move up or down one line at a time

Click on the scroll bar to move up or down one screen at a time
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Drag the scroll box up and down to a new position
To move through the text using the keyboard:

Press the up and down arrow keys to move up or down one line.

Press HOME to return to the beginning of the article

L

Press END to move to the end of the article

Press PAGE UP and PAGE DOWN to move up or down a screen.

Related Topics:

L

Preferences

b2

Navigating



Copy Article

Use the Copy Article command to copy the current article to the clipboard.



Sound

Finding Sounds in the Multimedia Browser
To find a sound, click the Media Button.

1 To look for a specific sound, type its name in the search entry box.
2 To look for all sounds in the program, select the sound icon in the Multimedia Filter.

&

3 To find sounds in a particular subject area, choose the subject from the subject list (eg., Birds).

Finding Sounds in the Articles
In the text of articles, sounds do not appear as separate multimedia items as they do on the Multimedia
Browser. In articles, all sounds are associated with pictures. When you pass the mouse over a
thumbnail that is associated with a sound, the pointer changes to a picture and sound icon.

&

Bring up the picture and click the sound button.

Playing Sounds

To play a sound, double click on its title in the Title list or on a picture thumbnail in an article (all sounds
are associated with pictures). Click the Play Sound Button _

@& The audio selections work best with a 16-bit sound card. If you have a sound
card installed but still cannot hear the sounds, check to make sure that the
proper drivers are installed. Consult your Windows or Macintosh manual for
instructions on installing drivers.



Thesaurus

The Thesaurus is located in the dictionary window and is activated in the same manner as the Dictionary,

by double clicking a word in the text of an article or by clicking the Thesaurus Button and entering a word
or phrase in the Search entry box.

Definitions appear in the pane to the right, synonyms in the lower Synonym pane. Double click a word in
the synonym list to get a definition of that word and a new list of synonyms.

- To activate BOTH the Thesaurus and the English dictionary, choose Dictionary
AND Thesaurus from the Options Menu.

L



Preferences Window

__General
_| Save current article on exit

_| Show pictures when displaying articles

| Show opening animation

Slide show delay IEI saconds

__Fonts
Article Font Arial -
Size 10 1'l point
__Colours
Highlighter || |v|

Article Find | | ~ |
Refer Yo% | I ~ |

OK Cancal I

In this example the settings are set to

:Save the current article on exiting

_Show thumbnails when displaying articles

Set the type as Arial 12 point

Display the cross references in green type

Display the highlights as light blue

Display the search terms in an article as dark blue



Quick Tour

Topic 1 of 15 (Click the right arrow to continue.)
Tour Guide

The Electronic Encyclopedia

An electronic reference work offers significant advantages over its printed counterpart. To begin with, a
CD-ROM can hold an enormous amount of information. The Canadian Encyclopedia Plus contains an
unprecedented amount of information, including the full texts of the revised and updated The Canadian
Encyclopedia, The Columbia Encyclopedia, The Gage Canadian Dictionary, an English-French/French-
English dictionary, articles from Maclean's magazine and a Timeline, as well as a thesaurus and over
4000 multimedia items. Powerful software provides almost instant access to all this content along with
means to save, copy, print, and organize information.

The following tour provides an introduction to the main features of the disk, along with links to areas of the
Help Program that provide more detail.



Search Menu

The Search menu is located in the upper right of the Encyclopedia Screen. Drop the menu down by
clicking the word Search or using the keyboard command Alt + S.

L g

Search
Canadian
Choose this item to view articles from The Canadian Encyclopedia and Maclean's magazine only.
Canadian and Columbia
Choose this option to view entries from both The Canadian Encyclopedia and the Columbia
Encyclopedia.

&

The Columbia Encyclopedia articles cannot be listed without the articles from The Canadian
Encyclopedia.

Internet Updates
Choose this option to get instructions about downloading updates from The Canadian
Encyclopedia Web Site.

Search History
Choose this menu item to view previous searches in the current session.

Find Word
Choose this menu item to find a word in the current article.



Question Menu

The Question menu is located in the upper centre of the Quiz window.

b2

Question
Reset Score
Choose this item to reset the score in the scoreboard to zero.

Random
Choose this item to display the quiz questions in a random order.

Sequential
Choose this option to display the quiz questions sequentially.

French/English
Use this menu item to switch from English to French versions of the questions.

Go To Question
Use this function to go to a certain question in the quiz.



Puzzle Menu

The Puzzle menu is located in the upper centre of the Quiz window.

b2

Puzzle
New Picture
Use this item to change the picture used in the puzzle. There are 40 choices.

Number Pieces
Choose this item to number the pieces to aid in solving the puzzle. If the pieces are numbered a
checkmark appears to the left of the menu item. Click again to remove the numbering.

Sound
Use this item to toggle the sound in the quiz on or off. A checkmark next to this menu item
indicates that the sound is currently set.



System Menu

The System menu is located in the extreme upper left of all the main screens. To drop the menu click the
Windows logo.

b

The Canadian Encyclopedia
About
Cick this item to find out about some of the people who created The Canadian Encyclopedia Plus.

Go to Home Screen
Choose this menu item to display the opening screen.

Preferences
Click this item to display the Preferences window.

Minimize

This item minimizes the program. Double click the icon to reactivate.
Close

Choose close to exit The Canadian Encyclopedia Plus.

Switch to..
Use this item to switch to another program that is currently running.



Advanced Button

Located in the Boolean Search Window. It provides access to the advanced search screen in which the
user can enter Boolean operators. (Boolean operators must be entered in capital letters.)



And Button

The And Button in the Search window adds an And Boolean operator to the search string.



Encyclopedia Button

_|ﬂqrclupedlu

The Encyclopedia Button is dimmed if you are in the Encyclopedia (main) Window. Click this button in
other windows (such as Dictionary) to return to Encyclopedia view.




Example Button

This button provides help for the Search and SmartSearch windows.



QuickSearch Button
I quicksearch I

Click this button in the Article Titles window or the Media Browser to see a list of article titles containing
your search term(s). Click on a title to display the article.



Go To Article Button

While viewing a picture, click the Go To Article button to go to the article relating to the current multimedia
item. If there is more than one article, a menu will appear.



Highlight Button

The Highlight button is located on the upper right of the Encyclopedia window. Use the button to highlight
text in the current article. The cursor will change to a highlight tool when you click this button. Click the
button again to turn off the tool.



Media Button
@

The Media Button in the lower right of the Encyclopedia, Dictionary, Quiz or Timeline screens opens the
Multimedia Browser.



Near Button

The Near Button inserts a near Boolean operator into a search.



Not Button

The Not button in the search window inserts a Not Boolean operator into the current search string.



Notes Button

The Article Notes Button opens the notes window so that text can be attached to the current article.



Or Button

The Or Button inserts an OR Boolean operator into the current search string.



Print Button

The Print Button in the Encyclopedia, Dictionary and Media Browser prints the current article, dictionary
entry or picture.



Pronunciation Key Button

Located in dictionary view, this button displays the pronunciation key for the dictionary.



Related Button

The Related Button is located in the upper right of the Encyclopedia screen. Click this button to display a
list of articles related to the current article, including a list of the cross references in the current article.



Quiz Button

Click the Quiz Button in the lower right of the Dictionary, Encyclopedia or Timeline screen to enter the
Canadiana quiz.



Boolean Search Button

The Boolean Search Button opens the Boolean Search window, in which searches can be performed
using AND, OR, NOT and NEAR.



SmartSearch Button

L

The SmartSearch Button launches SmartSearch, in which you can enter a plain language query or simply
a string of search terms.



Subjects Button

L

This button opens the subject list. Use this button to display lists of articles that are releated to one
another under common subject headings.



Tuner Button

The Tuner Button opens the Tuner in the search window. The Tuner is used to lend greater or lesser
importance to terms in a search string.



Thesaurus Button

The Thesaurus Button opens the thesaurus in the Dictionary window.



Search Button

In the Dictionary click this button to find all the entries that contain the search term or terms.



Wildcard Button

In the Dictionary, click this button to use wildcards to search for dictionary items when you are not sure of
the spelling of your term. The button lights up only when you enter a wildcard (* or ?).



Printing Related

@
Saving
@

Copying



Saving Related

&
Printing
L
Copying
&

Selecting Text



Copying Related

&
Printing
L
Saving
&

Bookmarks



Boolean Search

Activate Boolean Search or SmartSearch by clicking the appropriate button on the Encyclopedia Screen.

Simple Word Searches
To search for all entries in the encyclopedias that contain a single word:
1 Enter the word you are looking for in the Search entry box.
2 Click the Begin Search Button on the top right of the entry box or press Enter. If no articles satisfy the
search, you are informed that there are no matching articles. If several articles satisfy your search, they
will be listed in alphabetical order.

L

& If you have selected Canadian from the Search Menu, Search displays results
only from The Canadian Encyclopedia. Choose Canadian & Columbia to search
the Columbia Encyclopedia as well.

More Complex Searches
Search allows you to expand your search of the encyclopedia text by defining a relationship between
multiple terms (so-called Boolean searches).

Use Boolean operators (AND, OR, NOT and NEAR) to produce results that include all the keywords in
your topic or to a selective group of keywords.

And
1 Use the AND operator to find only those encyclopedia entries that contain all your terms.
Type the first term, choose AND from the Boolean Drop-down List and then enter your next term
in the second search box. You can enter up to 5 terms.
2 Click the Begin Search Button. The results will be listed in alphabetical order.

L

Or
1 Use OR operator to find all the articles that include any one or more of your terms.
Type the first term, choose OR from the Boolean Drop-down List and then enter your next term in
the second search box. You can enter up to 5 terms.
2 Click the Begin Search Button. The results will be listed in alphabetical order.

L

Not
1 Use the NOT operator to narrow your search by excluding terms.
Type the first term, choose NOT from the Boolean Drop-down List and then enter your next term
in the second search box. You can enter up to 5 terms.
2 Click the Begin Search Button. The results will be listed in alphabetical order.

Near
1 Use the NEAR operator to narrow your search to only those articles in which your terms appear close
(i.e. 8 words or less) to one another. This search is useful for finding personal names.
Type the first term, choose NEAR from the Boolean Drop-down List and then enter your next term
in the second search box. You can enter up to 5 terms.
2 Click the Begin Search Button. The results will be listed in alphabetical order.




AND
OR
NOT
NEAR

In Advanced search and in dictionary searches you can use the following
symbols for Boolean operators
&



Simple Word Search lllustration

L



And lllustration

In this examile the results list will include only those articles that contain ALL the terms.

Enter word(s) to describe your search.
Use the wards AND, OR, NOT. NEAR to make
youf search more specific.

Example I

| wolves |
[and *_or | not | near]

| coyotes |
FLI_E“I"_I |
dogs

[and *_or | not | near]

|Ameri-::a |

andI ar I not I nHarI
I |

__| Check for spelling mistakes

Seaﬂ:hl Al:hranoadl Close I




Or lllustration

In this illustration, the search results will include articles that include any one of the terms in search.

Enter word(s) to describe your search.
Use the waords AND, OR, NOT. NEAR to make
your search more specific.

Example I

| spallmucheen |

and l or not I nHaII

| gpallumcheen

and l or not I nHarI

| spallmunchen| |

andI or I not I nHaII

B check for spelling mistakes

Seaﬂ:hl Al:hranoadl Close I




Search Related

SmartSearch

&

Related Articles Search

&
Spelling Check

2

Accents




SmartSearch lllustration

whowas Mackenzie kKing?

CWilliam Lyon [QEDEERIE, politician, prime
minister of Canada 1921-26, 1926-30 and 1935-48
(b at Betlin [Kitchener], Ont 17 Dec 1874; d at
Oittawes 22 July 19507, grandson of William Lyon
L ASVIS. L eader of the LIBEERAL PARTY
1919-48, and prime minister for almost 22 of those
vears, [0ge was the dominant political figure in an
era of rajor changes. [0 graduated frorm U of T
in 1895 and studied economics at Chicago and
Harvard. In 1900 he became Canada's first deputy
minister of lahour; in 1908 he was elected in Morth
Yark as a Liberal and in 1909 entered Sir Wilfrid
LALIHIER's Cabinet ag minister of labour.

8 Mackenzie King Island
&d King, william Lyon Mackenzie
&3 Ralston, James Layton

8 Trudeau, Pierre Elliott

8 Beauharnois Scandal

¥ Magazines

8 Byng of Wirny, Julian Hedwoart]
8 Fogers, Norman McLeod

L= King, William Lyon Mackenzie

His interest in labour coincided with an expansion
in ranufacturing and a concern with industrial

relations. e acted as conciliator in a number of

RIS




SmartSearch Related

L

Boolean Search

&

Related Articles Search

&

Spelling Check

®

Tuner

@

Accents



Dictionary Related

&

Finding a Definition

garching for Terms
@
glagrams

zing Wildcards

Saving Definitions

b2

Thesaurus




Bookmark List Related
For more information on Bookmark Lists, click one of the following headings:

b2

Copying

Highlighting
e

Printing

e

Saving



Thesaurus Related

&

Finding a Definition

garching for Terms
gagrams
%ing Wildcards

b2

Saving Definitions




Title Index Related

@
Subject Index

b

Boolean Search

b2

SmartSearch



Subjects_Related

b

Boolean Search

b2

SmartSearch

b

Title Index



Scroll lllustration

ppearad in 1975, Leste




Searching the Multimedia

The Canadian Encyclopedia Plus contains over 4200 multimedia items distributed in over 7000 locations.
These items are categorized by type (video, sound, photo etc) and by subject (birds, trees, paintings, etc).

To Find Multimedia Using the Media Browser
1 Click the Media Button in the lower right of the Encyclopedia screen to launch the Multimedia Browser.

2 If the subjects list is not showing, click the Media By Subjects Button

Searching Media Types
1 When you open the Media Browser, by default all media items are shown.
2 To search for only one type of media (eg., videos), click its media icon. If you click all of the media
icons, all items will show.

Searching Media Subjects
To search all the subjects, click = All.
To search a subject area click the triangular button and then click a subject heading.
A list of the media titles that fit your filter and subject settings appears in the media title box on the left.
The number of items in the list is noted on the upper right hand corner of the browser.

BON-=

Searching Media Titles
To search for a media title, such as flounder or macdonald
1 Open the Multimedia Browser and type the name in the search entry box
2 Click view to view the item
3 If no titles match the search term, try clicking the QuickSearch Button to search for titles containing the
term.
4 You can also search for multimedia titles using regular Boolean Search and SmartSearch procedures.
The multimedia that satisfies the search will appear in the results list, marked by a multimedia icon.

L



Media Results Example

1) Lot show b [}

Canada Physical Features

| quicksearch | | media by subject

bl

[#= Canada Place
Jtm Canada Places

[#= Canada Six-Pence Stamp
[B= Canada's Coat of Arms

B Canada's GDP

Canada's Highest Waterfalls
Canada's Largest Islands, T:
Canada's Largest Lakes, Tat
Canada's Largest Resenairs
Bi- Canada's Learning Industry
Canada's Longest Rivers, Ta

[=

-




Tuner

The Tuner adds additional power and flexibility to searches of the encyclopedia text by allowing you to
assign a greater or lesser value to words. To use the Tuner, click the Tuner Button in SmartSearch.

Asslgn a lesser or greater Importance
to each word in your search.

canadian = || I ) I
||
french = (| I
hationalism et
hatiohalist el +

arigin = L+

Drigins =R S EE—

1 Enter your query in the query box.

2 Notice that the Tuner shows that SmartSearch has added words from the encyclopedias realted to
your terms, for example cows in addition to cow or Macdonald's in addition to Macdonald.

3 For each term use the mouse to slide the tuner to the right (to assign greater importance) or to the left
(less importance).

4 Click the Begin Search Button to proceed.



Article Source Indicator

This icon describes to which encyclopedia the current article belongs: maple leaf for The Canadian
Encyclopedia, world for Columbia and M for Maclean's magazine.



Cursor

When the mouse pointer is passed over multimedia items, the cursor changes to identify the type of
multimedia.



Titles Entry Box

Use the titles entry box to enter a search for a title. The list moves automatically through the alphabet as
you type.



Scroll Bar

Use the article scroll bar to scroll up or down the alphabetical list of articles.



Results Number

The number in this spot indicates the number of titles in your current search results.



Multimedia Filter Icon Bar

The icon bar identifies the kind of media included in the highlighted title. It is also used to include or
exclude types of media.



Scroll Down Button

Use this button to scroll down the current article using the mouse pointer.



Next Match Button

Use this button to move to the next match for your search term or terms.



Scroll Drag Button

Place the mouse pointer over this button and drag it to a new position in the article.



Scroll Up Button

Use this button to scroll up the current article using the mouse pointer.



Media Entry box

Use this box to enter your search term for a multimedia title. The list moves through the alphabet as you
type.



Media Title List

Icons to the left identify the type of media in this alphabetical list of multimedia titles. Double click an item
to bring up the Picture Viewer.



Photo Icon

Click this button to show photos and artwork in the multimedia list. If only this button is chosen, only
photos will show on the list.



Film Icon

Click this button to show film clips and animations in the multimedia list. If only this button is chosen, only
film clips and animations will show on the list.



Map Icon

Click this button to show maps in the multimedia list. If only this button is chosen, only maps will show on
the list.



Graph Icon

Click this button to show graphs in the multimedia list. If only this button is chosen, only graphs will show
on the list.



Table Icon

Click this button to show tables in the multimedia list. If only this button is chosen, only tables will show on
the list.



Sound Icon

Click this button to show sounds in the multimedia list. If only this button is chosen, only sounds will show
on the list.



Subject Expand Button

Use this button to expand or close the subject list.



All

Choose this item in the Subject List to display all multimedia items on the disk.



Multimedia Subject List

Use this list to find multimedia items on a particular topic such as Mammals, politics or Portraits.



Multimedia Items Count

This area identifies the number of items in the current subject.



Synonym List

This area lists the synonyms for the current term.



Dictionary Definition

The dictionary definition of the current term appears in this area.



Thesaurus Definition

The thesaurus definition of the current term appears in this area.



Dictionary Search Box

Enter your term or terms in this box.



Choose Dictionary Button

Click this button to display the dictionary only.



Content Button

Click this button to display the article contents, inicluding subheadings and multimedia.



Article Note Icon

This icon shows the location of the note in the current article.



Highlight Icon

The mouse pointer transforms to this icon when the highlight button is clicked, showing that the
highlighter is ready to highlight text.



Encyclopedia Screen Hypergraphic

Click on areas of the screen for descriptions.

i The Canadian Encyclopedia Pluz - [D:vedn_newPoetry.bmk]

|I]|_1,lmpi-:: Games

&) Olympic games

&} Olympic Mountains

&) Olympio, Sylvanus

& Olympus

& Olympus, Mount

&b Olynthus

& Om

&) Omagh

&) Omaha, city, United States

&} Omaha, indigenous people of
&) Oman

& Oman, Sir Charles William Ck

QuickSearch v
@ Olympic Games ||

- |}

Olympic Games

The original Olympic Games, which date
from 776 BC, exemplified the ancient
Greek pursuit of excellence and reverence
for physical beauty. The festival was held
every 4 years at Olympia, in the eastemn
Feloponnese, and included chariot and
horse races, foot races, boxing, wrestling,
and pentathlon. French aristocrat Baron de
Coubertin presided over the modern revival
of the Olympics, which were first held in
Athens in 1896, and the games have been held every 4 vears
since, except during war (1916, 1940 and 1344). Today they

| are by far the premier sporting event in the waorld.

Canadians first participated in the 1300
Olyrnpics, but Canada sent its first real

hational team — of 84 athletes —to London
in 1903. After the 1992 games in

CRRIR
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Articles and Subjects
Click the Titles Button in the upper left of the Encyclopedia screen to display an alphabetical list of all the
titles in The Canadian Encyclopedia and The Columbia Encyclopedia.

& Use the Search Menu to choose whether to display only entries from The
Canadian Encyclopedia or entries from both The Canadian Encyclopedia
and Columbia. You cannot display Columbia titles alone.

Finding Article Titles

1 Find an article by typing its name into the search box. As you type the list moves to the relevant part of
the list (e.g., "Tor" takes you to "Toronto")

2 |f there is no article beginning with your search term, or if you wish to find all articles that include your
term in its title, enter the term and click the QuickSearch. (For example, with only Canadian chosen in the
Search Menu, type "Congress" and the title list goes to "Congress Booted Out in India." Click
QuickSearch and a list of several other article titles appears.

e

Finding Subjects

1 Find Subjects by opening the Subject list with the Subject Button on the Encyclopedia Screen:

2 In the Encyclopedia Mode, expand the lists by clicking the right-pointing triangles (e.g. click the Sports
heading to find topics such as Hockey and click Hockey to find Canadian Hockey Players). Use the
Search Mode to search for a particular subject.

e
Click here for step by step instructions on How to Browse the Subject List
&

Click here for step by step instructions on How to Search the Subject List

Finding Articles that contain Multimedia

Use the media icons in the Multimedia Filter to display only those entries containing that type of
multimedia. For example, click the Photo icon to show only articles containing photographs. Click the
photo and the map icons to show articles containing pictures or maps, etc. Click on the icons below for
pop-up descriptions of the multimedia icons.
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The Canadian Encyclopedia+ contains over 4200 multimedia items, including pictures, maps, videos,
sounds, etc.

2

Finding Multimedia items

1 Open the Media Browser by clicking the Media Button. You can look for a multimedia item by typing its
name into the search box. As you type the list moves to the relevant part of the list (e.g., "Mac" takes you
to "Macdonald")

2 |If there is no item beginning with your search term, click the QuickSearch Button to see if there are
titles containing the term. For example, if you type "seal" in the search box, the list takes you
automatically to the item "Seal Cove." If you then click the QuickSearch Button, you get a list including
"Grey Seal," "Harbour Seal." etc.

3 Use the Subject Index to view items on particular subjects, such as Mammals or Portraits. To display
all items, choose All.

&

Click on the Media Button to view the Multimedia Browser.

The Media Filter
The multimedia filter bar allows you to include or exclude types of multimedia in your list. Click the icons
on the following graphic for descriptions.

&

If you want to show only one multimedia type, click the icon to the "on" (white background) status. Dim the
icon to exclude the multimedia type from your list.
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e
Displaying Pictures, Maps, Graphs, Tables
1 Double-click a multimedia title in the Media Browser list to activate the picture viewer

OR
2 Doubile click a thumbnail of a picture in the article text.
e
To close, click the Close Button.
e

To go to an associated article, click the Go to Article Button

To print, click the Print Button

b

To display a caption, click the Caption Button.

To view the next or previous multimedia item in the list, click the forward or back buttons on either side of
the Slide Show Button on the Media Browser.

media browser 528 iterm(s) || media by subject x
| 4] || stide show | || |} || acag| ¥ Al
[Abalone | I Animals =
Arts
Iﬂuinksaamhvl | media by subject | Coins, Stamps, Emblems
= Abalone =]l » Geography
&= Albertosaurus o History
L= Alderfly P Human Activities
[&= American Avocet Mative Feaple
[&= Ants b Plants
[#= Aphid b Paortraits
[8= Arctic Fox Science and Technology
[&= Arctic Ground Souirrel Statistics
[&= Arctic Ground Squirrel, Stand
[&= Arctic Hare
[&p Arctic Walf
[d= Arctic Walf, Frant Wiew b
e
Click on the highlighted title or the View button in the above graphic to view the Picture Viewer.
@
Activating Hotspots
2

To find hotspots on maps or pictures, move the mouse over the screen. When the cursor changes to a
hand and the picture displays in reverse colours, click to view the hotspot.



&

You must have 256-colour video drivers installed on your system for the optimum resolution of the
illustrations.
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To Search the Encyclopedia Text
The Canadian Encyclopedia Plus offers two different approaches to searching the text of the two
encyclopedias.

1 Boolean Search
Use Boolean Search to perform word or phrase searches or to use the traditional Boolean operators: and,
or, not and near.

To activate Boolean Search

Click the Boolean Search Button in the upper left of the Encyclopedia window.

b2

Enter your search term

Enter additional terms, clicking a Boolean operator for each one
And to find only those articles containing all your search terms
Or to find those articles with any one, or combinations of your terms
Not to find any articles that exclude one or more terms
Near to find only those articles in which your terms appear close to one another
ge Advanced to enter your own Boolean operators. (The operators must be in capital letters.)
Click here for help with the Boolean Search Screen.
When you view an article from your results list, the section of the article
containing the first match to your term or terms is displayed highlighted in the

text. Click on the pointer @ in the scroll bar to go to the next or previous match.

2 SmartSearch

Use SmartSearch to perform general searches in which the program evaluates your search terms to find
the best match for your query

® To activate SmartSearch

Click the SmartSearch Button

Enter your query as a string of words or as a question in everyday language.

To refine your search, open the Tuner by clicking the Tuner Button and use the sliders to give greater or
lesser importance to individual terms. (The tuner will include words related to the terms you have
entered.)

e

Click here for help with the SmartSearch Screen.

@& In SmartSearch the results list is presented in the order in which the articles
most closely matching your query appear at the top of the list. In Boolean
searches, the results appear in alphabetical order.

Preview

&



Preview articles in the results list by clicking the Preview Button.

2

View the articles by double clicking on the title.
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Navigating Encyclopedia Articles
The functions related specifically to the text of the encyclopedia articles are located in the upper right of
the Encyclopedia screen and in the menus.

To find a Word in the text of an article
Click the Search Menu and choose Find Word
gter your term or terms in the Word Find Dialog box
Click the Begin Search Button or press ENTER
To Move to a section of the text or to a Multimedia item
Click the Article Contents Button in the upper right of the Encyclopedia screen.

e

Click a subhead to move to that section of the article (e.g. the Economy section of the article on Alberta).

Click on a multimedia item in the Contents to view or play the multimedia contained in the article.

To find articles Related to the current article
0 Click the Related Button in the upper right of the Encyclopedia screen.

& The Related results list includes related multimedia items and cross references
from within the article text as well as the results of a SmartSearch on the article
text. If you run a Related search on selected text, the results will not inlclude
the cross references.

To move to previous Articles and to related Subjects

b2

Move to the previous article viewed by clicking the Last Article Button or choose History from the Article
Menu to view a list of all articles viewed in the current session

Click the More in Subject Button to display a list of titles in the same subject index as the current article

To move through the text, use the scroll bar down the right-hand side:

b
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Bookmarks

The bookmark functions of The Canadian Encyclopedia Plus enable you to keep records of articles of
special interest, to add notes to articles, to highlight text within articles for future reference and to keep
lists of articles and multimedia items.

To open a new or existing Bookmark List

Click on the Bookmark Menu in the Encyclopedia Screen or click the Bookmark Button

&

In the Bookmarks List
Choose View Bookmark List

To include an article in a Bookmark List

b

Mark the current article by clicking the Add Bookmark Button on the upper-right of the Encyclopedia
screen or by choosing "Add" from the Bookmarks Menu.

b

Mark a multimedia item by clicking the Add Bookmark Button on the Media Browser.

To Highlight text in an article for future reference

L 2

Display an article by double clicking its title in the Titles list.

Add the article to your bookmark list by clicking the Add Bookmark Button

Single click the Highlight Button. (The mouse pointer will change to resemble the outline of a highlight
marker and will remain active until you click the Highlight Button again.)

&

Drag the mouse pointer over the text. The highlights will remain until you remove them.
To add a note to a Bookmark List

&play the article to which you want to add a note.

Single click on the Note Button.

gck the part of the article where you want the note to appear.

Double click the note icon that you have placed in the text.

Add the note to the notepad.
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Using the Dictionaries and Thesaurus
The Dictionaries allow you to find definitions in English or French by entering your own terms or by simply
double-clicking on any word in the text of the encyclopedia articles.

To find a definition in the Dictionary

e

Click on the Dictionary Button on the lower right of the Encyclopedia, Timeline or Quiz screen.

&

Choose Dictionary for English only.

Enter your term in the definition box.

&

Click the Definition Button.

To search for all dictionary entries that contain your term, click the Search Button.
To find a translation in the Dictionary
Click on the Dictionary Button on the lower right of the Encyclopedia, Timeline or Quiz screen.

&

Choose French-English or English-French.

Enter your term in the translation box.

e

Click the Translation Button.

2

To search for all dictionary entries that contain your term, click the Search Button.

To look up a word directly from the text of the encyclopedias
Double click the word with the mouse.
To look up a word in the Thesaurus

&

Click on the Dictionary Button on the lower right of the Encyclopedia, Timeline or Quiz screen.

Click the Thesaurus Button in the upper left.

&

Enter your term in the search box.

e

Click the Synonym Button. A list of synonyms appears.

To look up a word in both the Dictionary and Thesaurus

e

Choose Dictionary & Thesaurus from the Dictionary Menu.



e

Click here to get detailed help on the Dictionary Screen.



Dictionary Hypergraphic

Click on areas of the screen for descriptions.

i The Canadian Encyclopedia Pluzs - [untitled]

Translation

mf— English m :
| Translation|

card | Conjugate |

|-E|"||'Dil

I Search | Anagram l

accés
accointances
accordéon
actif
affaire
affection

avoir [ 3vwar]

Anm

1. [hiens] assets {pl.)

2. [document] credit note

B. v aux

to have

Jai finf

| have finished

il a attendu pendant deux heures
he waited for twao hours

C.w b

1. [posséder] to have (got)

il a deux enfants/ les cheveux bruns
he has (got) two children/ brown hair
fa maison a un qrand jardin

the house has (got) a large garden
2. [étre agé de]:

ila 20 ans

he is 20 (years old)

il a deux ans de plus que son frére
he is bwn wears alder than his hrother

=




Quick Tour

Topic 13 of 15 (Click the right arrow to continue and the left to go back.)
Tour Guide

Answering the Quiz

b 2

Launch the encyclopedia quiz by clicking the Quiz Button on the Encyclopedia, Dictionary or Timeline
Screen or by choosing Quiz from the Navigation Menu.

Click here to view the Quiz Screen.

Answering a Question
&
Answer a question by choosing the appropriate letter button associated with the question. If the answer is
correct, a piece of the puzzle appears to the right and your score is registered on the scoreboard. Click
the New Question Button to display the next question.

Getting a Clue

If you do not know the answer or want to find out more about the subject of the question, click the Clue
Button to go to the relevant encyclopedia article.

Solving the Puzzle
When you have completed the quiz, you can try to solve the puzzle by moving the pieces with the mouse.
The puzzle is similar to the small games with push tablets familiar to children. Click the Puzzle Hint Button
to move one piece or the Solve Button to solve the entire puzzle. The Scramble Button rescrambles the
puzzle.
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Printing,Saving, Copying
&
e

Choose Print Article from the File Menu in the Encyclopedia window or Print Entry from the File Menu in
Dictionary view. If you have selected text, Print will offer the option of printing the whole article (or
definition) or of printing the selected text.

&
b2

Choose Save Article from the File Menu in the Encyclopedia windows or Save Entry from the File Menu in
Dictionary view. If you have selected text, Save will offer the option of saving the whole article (or
definition) or of saving the selected text.

b

To print an article or dictionary entry

To save an article or dictionary entry

To print a picture

Click the Print Button on the Picture viewer. To print a frame from a video clip, pause the video and click
the Print Button. Printing pictures can be slow!

L

To copy text
Select the text with the mouse pointer held down
&

Choose Copy from the Edit Menu, or

Use the Windows or Macintosh keyboard commands



Scroll lllustration

L



Previous Match Button

Click this button to go to the previous match of your search term.



Multimedia Browse Screen Hypergraphic
&

Click on areas of the screen for descriptions.



Multimedia Items

This area shows the number of multimedia items in the current list.
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Encyclopedia Screen
The Encyclopedia Screen is the main screen for accessing the features related to the encyclopedia. Click

on areas of the screen for descriptions.

b
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Dictionary Screen

The Dictionary Screen is the main screen for accessing the features related to the dictionary and
thesaurus. Click on areas of the screen for descriptions.

' The £anadian Encyclopedia Plus - [untitled]

Translation

awvoir [ Svwar]

A nom

1. [hiens] assets pl.)

2. [document] credit note

B. v aux

to have

Jjai fini
e ey I ha"."e ﬁnIShEd

il a attendu pendant deux heures
he waited far two haurs

C.wv tr

1. [posséder] to have (got)

il a deux enfants’ les cheveux hruns
he has (gaot) twa childrend brown hair
fa maison a un qrand jardin

the house has (got) a large garden
2. [étre agé de]:

ila 20 ans

he is 20 (years old)

il a2 deux ans de plus que son frére =
he is twn wears alder than his hrothar w

ﬁ_":- English m e
| Translutlnnl

Search | Anagram | - | Conjugate |

[ IR

|-E|‘|"Dil

Acces
accointances
accordéon
actif
affaire
affection
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Multimedia Browser Screen

The Multimedia Browser Screen is the main screen for finding, displaying and playing the multimedia.
Click on areas of the screen for descriptions.

b



Screens

/’Encyclupedia\qﬂictiunaries\{ Media \‘.: Quiz

\{Buukmarké“{ Timeline \{ Search '\

Quiz Screen

The Quiz Screen is the main screen for playing the quiz and solving the puzzle. Click on areas of the
screen for descriptions.
' The Canadian Encyclopedia Plus - [untitled]

"l . Select an answer.

The Canadian boxer, shown fighting Mohammed Ali, who
was never knocked dowwn in 96 fights was

il Yyon Durrelle
b | George Chuvalo

il Lennox Lewis

beda 'L".Fl'.c:

8.3

@
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Bookmarks List Screen

The Bookmarks List Screen is the main screen used for managing bookmarks. Click on areas of the
screen for descriptions.

&
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Timeline Screen

The Timeline Screen is the screen used for accessing the Timeline of Canadian and World history. Click
on areas of the screen for descriptions.

' The £anadian Encyclopedia Plus - [untitled]

Select a period:
All

Age of Dinosadrs Bedins
Small Primates Appear

First Humans Appear

Morh Armerican Glaciation
Humans Use First Tools
Wisconsin Glaciation Begins
First Mations Cross Beringia
Bone Scraper at Old Crowy
First Cave Paintinns

Bin Game Hunters

lce-free Corridors

Bluefish Caves

Miagara Falls Created
Clovis and Folsom Cultures

e o e iz

R

| mammoths, horses, camels and
| giant sloths moved into the Americas.

Date: 20 thousand years ago to 50
thousand years ago

Period: Pre-Human

Categorny: Environment

Event: The age of mammals.
Animals such as mastodons and
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Search Windows Screens

The Search Windows Screens are used for performing searches of the encyclopedias. Click on areas of
the screen for descriptions.

You may enter words or questions
that describe your research or Intarest.

Canadians through governments
bazed on elected parliaments
gradually acquired command of
then own political concerns,

thereby achieving national
self-direction without revolution|




Photographs

Icon for photographs



Video Clips

Icon for video clips.



Maps

Icon for maps.



Graphs

Icon for graphs.



Tables

Icon for tables.



Sound Clips

Icon for sound clips.



Animations

Icon for animations.



Word Find lllustration




Clue Button

Use this button to go to articles in the encyclopedia that will contain information about the questions and
answers.



New Question Button

Use this button to go to a new question.



Puzzle Menu




Hint Button

Use the Hint Button in the Quiz to get a hint about how to solve the puzzle.



Scramble Button

Use the scramble button to rescramble the puzzle.



Solve Button

Use this button to solve the puzzle.



Quiz Button Dimmed

In Quiz mode the Quiz button is dimmed.



Question

There are 450 questions which are brought up in random order if you choose Random from the Question
Menu or sequentially if you choose that option.



Answer Buttons

Click the button next to the correct answer.



Puzzle

One piece of the puzzle appears with each correct answer. Solve the puzzle when all the pieces are
present.



Scoreboard

The scoreboard keeps track of your record in the current session.
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The Encyclopedia Screen

The main, or Encyclopedia, screen displays the text of the Canadian and Columbia encyclopedias and
provides access to most of the functions of the program through buttons, icons and menus. Similar types
of functions are concentrated in specific areas of the screen.

Go to the Encyclopedia screen after starting the program by clicking on the encyclopedia bar on the home
screen, and from within the program by choosing Encyclopedia on the Navigation menu or by clicking the
Encyclopedia Button in the lower right hand corner.

&

Click on the Encyclopedia Button to explore the features of the Encyclopedia Screen.



Near

Use the NEAR operator (~) to find only those articles in which your search terms appear within a few
words of one another.
For example, if you search for the words Canada AND council, you will turn up 803 results when
searching The Canadian Encyclopedia. If you search for Canada NEAR council the results are
narrowed to 297, increasing the likelihood that you are finding the organization Canada Council.



Tour Picture Viewer
L
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The Encyclopedia Screen Functions

The Encyclopedia Screen provides all the functions you need to find and use information in the combined
60 000 articles of The Canadian Encyclopedia and The Columbia Encyclopedia.

The Menu Bar

The menu bar across the top of the screen provides easy access to numerous functions, such as
navigating through the program, copying or printing, adding bookmarks, etc. Some of these functions,
such as navigation, are also available through buttons on other parts of the screen. For more information
on the menus, go to Menus.

Tool Bar
last article [ article contents W

Beneath the Menu Bar, a Tool Bar provides various functions related to the current article on view. The
Tool Bar includes a Bookmark Button, an Add Bookmark Button, a Related Button, a Last Article Button,
an Article Contents Button, a Notes Button, and a Highlight Button. The Help Button launches the help
program and the Canadian or Columbia icon indicates whether the current article is from The Canadian
Encyclopedia or The Columbia Encyclopedia.

Search Buttons

&

In the upper left area of the Encyclopedia screen, four buttons provide four means of searching through
the encyclopedia articles: the Titles Button, the Subjects Button, the Boolean Search Button and the
SmartSearch Button. For more information on searching the encyclopedia articles, go to Searching the

Encyclopedia Texts.

Navigation Buttons

On the lower right area of the Encyclopedia screen, the Quiz Button, Dictionary Button, Timeline Button,
Media Button, and Encyclopedia Button navigate to different areas of the program. When an area is
active, the button is dimmed.

Titles Area

The titles area beneath the search buttons displays a list of encyclopedia titles according to the function
chosen. For example, when the Titles Button is chosen, the area shows the alphabetical list of titles. After
a Boolean or SmartSearch, a results list appears. The media icons beneath the titles are used to select
articles according to the media they contain (see Media Filters).
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To Play Videos and Animations
Display a list of media in the media list window by clicking the Media Button. Locate the item and

To play, click the Play Button.
To pause, click the Pause Button.
Click here to view the Video Player.

- You must have QuickTime properly installed to play the video clips. Video places
huge demands on your system. The more processing speed and available RAM,
the smoother the results will be.

To Play QuickTime VR

To play, double click a VR clip in the Media Browser.

Hold down the mouse and move it in the direction you wish to move
Click here to get more information on How to Use QuickTime VR
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Playing Sounds
1 Since all sounds are associated with a picture

b 2

Display the picture as explained above.

Click the Sound Button.
2 Find a sound on the Media Browser and double click.

& For accurate playback of the sounds and of sound on the video clips you
should have a 16-bit sound card installed on your computer.



Tour Video Player

Click on areas of the screen for descriptions.

L



Quiz Screen Hypergraphic

i The Canadian Encyclopedia Pluz - [untitled]

The Canadian boxer, shown fighting Mohammed Ali, who
was never knocked down in 96 fights was

_a | vvon Durrelle
_b | George Chuvalo

c | Lennox Lewis

Scramble 4 Solve
M. Pieces Bl Puzzle




How Do | ?

Find a list of every encyclopedia article title?

gwoose Canadian & Columbia from the Search Menu
Click the Titles Button
Find a list of titles from The Canadian Encyclopedia?
goose Canadian from the Search Menu
Click the Titles Button
Find a list of articles that contain photographs?
Click the Titles Button
e
Click the photo icon in the multimedia filter at the bottom of the title list.
Find a list of articles that contain different multimedia?
Click the Titles Button
e
Click the icons of the different media in the multimedia filter at the bottom of the title list.
Find a particular article?
Click the Titles Button
Type the name in the entry box.
The list moves automatically to the location of the article.
Find all articles that contain a certain word, eg, Canada?
Click the Titles Button
Enter the word Canada in the entry box.

&

Click the QuickSearch Button.
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Quick Tour Start

Encyclopedia Screen

Encyclopedia Screen Functions
Articles and Subjects

Finding Multimedia Items
Displaying Pictures

Playing Videos

Playing Sounds

Searching the Encyclopedia Texts
Navigating the Encyclopedia Articles
Bookmark List

Using the dictionary and Thesaurus
Answering the Quiz

Printing, Saving, Copying

Help Contents



Dictionary Display Button

Click this button on the upper left of the Dictionary screen to display the Gage Canadian Dictionary.



Preview Button

Click this button to preview an article from a results screen. Click the View Button to go to the whole
article.



Trash Button

Use this button on the Bookmarks screen to delete the highlighted object in the Bookmark List.



Caption Button

Use this button on the Multimedia Browser to display the caption.



Play Sound Button

Use this button on the Multimedia viewer screen to play a sound. If no sound is associated with the
picture, the button is dimmed.



Dictionary Menu

The Dictionary menu is located in the upper centre of the Dictionary screen.

b2

Dictionary
Dictionary
Click this item to choose the Gage Canadian Dictionary (to find definitions of English words)

Thesaurus
Click this item to use the thesaurus.

Dictionary & Thesaurus
Click this item to use both the Gage Canadian Dictionary and the thesaurus.

French-English
Choose this item to use the French-English dictionary (to find English translations of French
words).

English-French
Choose this item to use the English-fFench dictionary (to find French translations of English
words).



Accents

When searching for terms with accented characters, such as Montréal, you must enter the accented
character using the ASCII codes, or Select the term (see Selecting Text) in an article and click the Related
Button.

The following are some common characters in Windows:

a= Alt + 0224 i=Alt+ 0238

d= Alt + 0206 = Alt + D206

e=Alt + 138 d = Alt + 0244

&= Alt + 130 ¢c=Alt+135

6= Alt + 136 6= Alt + 137
&

When typing the number you must use the Number Pad.



Article Contents Button

Click the Article Contents Button to display the drop-down menu of article contents.The contents menu
lists all the headings and all the multimedia contained in the current article.



Related Related

&

SmartSearch

&

Cross References

2

Selecting Text




Dialog Box

A dialog box is a window that displays options (such as Preferences) or that requires the user to enter text
into a text entry box (such as the windows that appear when you click the Search or SmartSearch
buttons.



Video Slide Button

Use this button to begin a slide show of multimedia items using the current media subects and multimedia
filters.



Highlighting Related

b

Selecting Text



Selecting Text Related

&

Finding Related Articles

®

Highlighting Text




Adding Notes Related

&

Selecting Text



Highlighted Text

Highlighted text appears in the colour set in Preferences.



Viewer Sound Button

This button is dimmed if no sound is associated with the picture. If the button is lighted, click to hear the
sound.



Slide Show Button

Click the slide show button to initiate a slide show using your current settings for the media filter and for
the multimedia subjects. When the Slide show begins the button toggles to read Stop Slide Show.



Bookmark Button
|W

The Bookmark Button opens the Bookmarks List window.



Add Bookmark Button

The Add Bookmark Button adds the current article on view to the current bookmark list.



Last Article Button

last article [+

The Last Article Button displays the previously viewed article.



Subjects Button

L

The Subjects Button opens the Subject Index to the articles of the encyclopedias.



Timeline Button

The Timeline Button is located in the lower right of most screens. Click this button to open the Timeline.



More in Subject Button

The More in Subject Button appears at the foot of an encyclopedia article, next to the subject of the
current article. Click the button to display the titles of other articles in the same subject.



Translation Button

The Translation Button appears in the Dictionary when French-English or English-French are chosen.
Click the button to translate the term you have entered.



Synonym Button

The Synonym Button appears in the Dictionary when Thesaurus has been activated. Enter the term and
click the button to find a list of synonyms.



New Question Button

Click the New Question Button in the quiz to display a new question.
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The Timeline
The Timeline includes over 3000 events in Canadian and world history, organized by Categories and
Periods. The reader can search the events by date, find a list of Canadian firsts and view the Macleans
year in review entries.

Opening the Timeline

To Activate the Timeline, click the Timeline Button in the Encyclopedia, Dictionary or Quiz screens.

L

Categories

e

Select Categories by clicking on the Categories Button and then choosing a category from the Categories
graphic. For example find a list of events describing Acts and Treaties by clicking on the Acts and Treaties
box.

Periods

Select Periods by clicking on the Periods Button and then choosing a period from the Periods graphic. For
example find a list of events describing Early New France by clicking on the Early New France section of
the Period graphic.

- Pointing the mouse to the right of the Categories or Period graphics automatically
moves the graphic without the scroll bar.

Other Functions
Click the Search by Date Button to search for events that happened on a certain day.

b

Click the Year in Review Button to view the Maclean"s entries by month.

Click the On this Day Button to find events that happened on a certain day.

Click the Canadian Firsts Button to find descriptions of Canadian firsts.

e

Click here for help on the Timeline Screen.

Click here for more detailed help on the Timeline.



The French-English Dictionary

Use the bilingual dictionary to translate words to and from English and French
1 Translation from English to French

To translate a word from English to French, click the English-French Button

b

Type in your term and Click the Translation Button. To find all the places the word appears in French
entries in the dictionary, click the Search Button.

2 Translation from French to English

b2

To translate a word from French to English, click the French-English Button

&

Type in your term and Click the Translation Button. To find all the places the word appears in English
entries in the dictionary, click the Search Button.
& You can enter French Accents into the dictionary search box by using the
Character Map (in Accessories in Windows), or by using the codes outlined in the
table below:

3 Conjugation of French Verbs

To conjugate a French verb, enter the verb into the search box and click the Conjugate Button. Choose
the verb tense from the Tenses list.



Contacting TCE Sales
To contact The Canadian Encyclopedia sales department, call 1-800-788-1074.



Contacting TCE Technical Support
To contact The Canadian Encyclopedia technical support, call 1-800-647-0639.



Contacting the TCE WEB site

The Canadian Encyclopedia site on the World Wide Web provides information about the creation of The
Canadian Encyclopedia, updates of encyclopedia articles and a selection of new articles from Maclean's
magazine. YOU MUST BE CONNECTED TO THE INTERNET FOR THIS TO WORK!

Click here for Alinternet Access to The Canadian Encyclopedia+ Web Site.



Creating and Managing Bookmarks
Step 1: Create or Open a Bookmark List
1. Creating a Bookmark List

You create a Bookmark List by

b

Opening the Bookmark List Viewer

L

Naming a Bookmark List

L

Saving a Bookmark List

2. Opening a Bookmark List

Opening the Bookmark List Viewer

L

Choosing a Bookmark List

L2

Go to Step 2.




Save Bookmark Button

The Save Bookmark Button is located on the Bookmark List window. Click this button to save the current
Bookmark List.



Opening the Bookmark List Viewer

Open the Bookmark List Viewer by clicking the Bookmark Button e



Naming the Bookmark List

Name a new Bookmark List by clicking the New List Button in the Bookmark List Viewer, or choosing
Open from the File Menu. Click the Save Button and enter the name in the Save As dialog box.



Saving the Bookmark List

After typing the name of the new Bookmark in the dialog box, click the Save Bookmark Button.

The new Bookmark is now the default list. All marked articles will be added to this list.



Choosing the Bookmark List

Senum Q|
¢

Click the Open List Button, or choose Open from the File Menu to display the Open Bookmark window.

&

Choose the Bookmark and click the Open Button.

L2

A list of articles and multimedia in the list appears in the Bookmarks List window.



Creating and Managing Bookmarks
Step 2: Managing a Bookmark List
1. Displaying a Bookmark List

If a list is currently open

Click the Bookmark Button, OR

&

Choose View Bookmark from the Bookmark Menu
If you wish to change and view a different list

L

Open the Bookmarks List window

Click the Open List Button, OR

L

Choose Open from the File Menu

L

Choose a new list
2. Saving changes to the current Bookmark List

Choose Save List from the File Menu, OR

b

Open the Bookmarks List window and click the Save Button, OR

L

Choose Save As from the File Menu and give the Bookmark a new name or path

3 Printing the current Bookmark List

L

Open the Bookmarks List window

L

Choose Print List from the File Menu

L

Go to Step 3




Creating and Managing Bookmarks

Step 3: Adding and Deleting Bookmark Items

1. To add the current encyclopedia article to a Bookmark List
display the article

click the Add Bookmark Button, or

choose Add " " from the Bookmark Menu
2. To add selected titles to a Bookmark List

go to the Titles List or a search results list

&

select from the list

choose Add Selected from List from the Bookmark Menu
2. To add a multimedia item to a Bookmark List

?pen the Multimedia Browser, OR

display multimedia from a thumbnail within an article

click the Bookmark Button on the media browser, OR

choose Add" " from the Bookmark Menu

b2

Goto Step 4



Creating and Managing Bookmarks
Step 4: Adding Notes to Bookmarks

Two kinds of notes can be added to Bookmarks: individual notes which are added to articles and general
notes which are added to Bookmark Lists.

To add a note to an article
In order to add notes to an item, that item must be marked as part of a Bookmark List (see Step 3). When
an article is part of a Bookmark List, a Notes Button appears on the tool bar.

Click the Note Button and drop the note in the article

b
b 2

Type a note in the Article Note box
Close the Article Note window by clicking on the Close Button
To add a general note to a Bookmark List

L 2

Open the Bookmarks List Window

Double Click the General Notes Button

b 2

Type your note in the List Notes dialog box.

b2

Go to Step 5




How To Add a Note

*C

click the Note Button

®

drag the cursor to the part of the article where you want the note to appear

®

click the note

@

ouble click the Postit icon to bring up the Article Note window

o



Creating and Managing Bookmarks
Step 5: Adding Highlights to Bookmark Items

- In order to add highlights to an item, that item must be marked as part of a
Bookmark List (see Step 3).
When an article is part of a Bookmark List, a Highlight Button appears on the tool bar.
1. To add highlights
click the Highlights Button, OR
choose Highlight from the Bookmark Menu (the cursor changes to form the outline of a highlighter)
hold down the mouse button and drag the mouse over the text
2. To turn off the Highlighter
%ck the Highlight Button again, OR
unclick Highlight on the Bookmark Menu
3. To clear Highlights
activate the Highlighter by clicking the Highlight Button and drag the mouse over the highlighted text, OR

L

choose Clear Highlights from the Bookmark Menu

Go back to Step 1



Open List Button

L

The Open List Button on the Bookmark window opens an existing Bookmark List.



New List Button

The New List Button on the Bookmarks List window creates a new Bookmark List. Click the button and
enter the new list title.



Bookmark Dialog Box

Cotcaplus\Poetry

The Bookmark dialog box is used to enter the name of a new Bookmark List or it displays the title and
path of the current Bookmark List.



Bookmark List

This area of the Bookmarks List window displays the titles of the items included in the current Bookmark
List.

How to select from a list



How to Select From a List

To select a single item from a list
@ click the mouse or move the cursor to a title

To select a range of items

@ click on the first item

@ move to the last item using the scroll bar

@ click the mouse while holding down the Shift key

To select random titles

@ click on the first item with the mouse

@ move to the next item using the scroll bar

@ click the next item while holding down the CTL key



Bookmark List Button

The red Bookmark List Notes Button is located on the Bookmarks List Viewer.
Bookmark List Notes

Click this button to bring up the Bookmark List Note dialog box and add notes to you Bookmark List.



List Note

The List Note dialog box is used to add a general note to a Bookmark List and to print or to delete a note.
Open the List Note dialog box by clicking the General Note Button in the Bookmarks List Viewer.

A research folder on poetry might
include articlez on poets from
around the world, Canadian
poets, and media such as video
and sound clips |



Save Button

The Save Button saves the current article or dictionary entry.



Maximize Button

The Maximize Button maximizes the screen.



Minimize Button

The Minimize Button minimizes the screen.



Help Menu

L

Help
Help
Choose this item to launch the online Help program.

About
Choose About to see a list of some of the people who created the encyclopedia.



Article Menu

L

Article
Previous
Choose this item to view the article viewed immediately before the current article.

History
Choose this option to view a list of previously viewed artices in the current session.

Related
Choose Related to view articles related to the current article.




Bookmark Menu

L 2

Bookmark

Add
Choose this item to add the current article to the current Bookmark List. If the current article is
already part of a list, this item toggles to Delete.

Select from List
Choose this option when you want to add items from lists, such as the title index or a list of titles
in a search result, to the current Bookmark List.

View Bookmark List
Choose this option to view the current Bookmark List.

Annotation
Choose this item to add a note to the current article. This item is dimmed until the current article is
added to a Bookmark List.

Highlight
Choose this item to add highlights to the current article. NOTE: This item is dimmed until the
current article is added to a Bookmark List.

Clear Highlights
Choose this option to clear highlights from the current article.



Mode Menu

L 2

Bookmark
Titles
Choose this item to display the Article Titles List.

Subjects
Choose this option to view the Subject List. (Subjects are general topics which group lists of
related articles.)

Boolean Search
Choose this item to open the Boolean Search window.

SmartSearch
Choose this item to open the SmartSearch window.



Navigation Menu

L

Navigation
Encyclopedia
Choose this item to go to the Encyclopedia screen.

Dictionary
Choose this option to to go to the Dictionary screen.

Quiz
Choose this option to to go to the Quiz screen.

Timeline
Choose this option to to go to the Timeline screen.

Media
Choose this option to to go to the Media Browser.



Edit Menu

& This menu changes in different modes
e
Encyclopedia Mode
Edit
Copy Selected Text Ctrl+C
Choose this item to copy selected text. Note that this item is dimmed if no text is selected.
Copy Article
Choose this option to copy the entire current article.
e
Dictionary Mode
e
Edit

Copy List
Choose this item to copy the current list of words.

Copy Entry
Choose this option to copy the current dictionary entry.



File Menu

& This menu changes in different modes

b2

Encyclopedia Mode

File
New
Choose this item to begin a new Bookmark List.

Open
Choose this option to open a Bookmark List.

Close
Choose this option to close the current Bookmark List.

Save List
Choose this option to save the current Bookmark List.

Save List As
Choose this option to save the current Bookmark List with a different name or path.

Save Article
Choose this option to save the current article to disk.

Print List
Choose this option to print the current Bookmark List.

Print Article Ctri+P
Choose this option to print the current article.

Print Setup
Choose this option to set up your printer.

Preferences
Choose this option to set your preferences.

Exit
Choose this option to exit the program.

e

Click here to view the File Menu in Dictionary Mode

e

Click here to view the File Menu in Quiz Mode




Control Menu

e
File
Go to Home Screen
Choose this item to return to the Home Screen (the screen that shows when the program opens).

Restore
Choose this option to restore the program to its previous size.

Minimize
Choose this option to minimize the program.

Maximize
Choose this option to maximize the program.

Close
Choose this option to close (exit) the program.

Switch To
Choose this option to switch to another program that is running at the same time as The
Canadian Encyclopedia+.



Title Bar

The title bar contains the name of the currently open Bookmark List. If the Bookmark List has not been
saved, the title bar lists it as [Unititled].



Timeline

Introduction

To enter the Timeline, click the Timeline Button on the Encyclopedia or Dictionary screens or choose
Timeline from the Navigation Menu.

The events in Timeline are arranged in several different categories. Click on the appropriate topic for a
description of each.

@

Categories

Canadian Firsts

On This Day

@

Periods

@

Search by Date

@

Year in Review

@

Click here for a complete description of the Timeline Screen.



Timeline

Categories

Use categories in the Timeline to view Canadian events grouped under categories, such as Education or
Science.
To view events by categories

Click the Category Button

Choose a category by moving the cursor over the main Category Screen.
& Scroll the main Category Screen by pointing the cursor off the right edge of the
screen to move right or off the right edge of the screen to move right.
&

Click on a category to display a list of events.

Scroll through the events using the scroll bar.

b

View events in the Event Screen.

To return to the main Category Screen

L

Click Choose a Category and pick All from the drop-down list.

Related

@

Canadian Firsts

@

On This Day

®

Periods

@

Search by Date

@

Year in Review

@

Click here for a complete description of the Timeline Screen.



Timeline

Periods

To view events by periods

b

Click the Period Button

Choose a period by moving the cursor over the main Category Screen.
Scroll the main Period Screen by pointing the cursor off the right edge of the
screen to move right or off the left edge of the screen to move left.

L

Click on a period to display a list of events.

Scroll through the events using the scroll bar.

b

View events in the Event Screen.

To return to the main Period Screen

L 2

Click Choose a Period and pick All from the drop-down list.

Related

&
Categories

&

Canadian Firsts

On This Day
@
Search by Date

b

Year in Review

e

Click here for a complete description of the Timeline Screen.



Timeline

Search by Date

To search for events by date

b

Click on the Search by Date Button.

Choose the time frame by entering the year and month for both the beginning and end.

L

Type in the years and choose the months from the Drop-down Menu.

Click the Search by Date Button.
View events in the Event Screen.

Related

@

Categories

Canadian Firsts

@

On This Day

@

Periods

®

Year in Review

@

Click here for a complete description of the Timeline Screen.



Timeline

Year in Review

To search the Maclean's Year in Review articles

b

Click on the Year in Review Button.

Choose the time frame by choosing a year and month from the main Year in Review screen, OR
&

Choose year and month from the drop-down menu.

Select an issue

Al
January 1995
February 1995
March 19945
April 18845
May 1995
June 19945
July 1995
Algust 19945
September 19494
Qctober 1995
Movember 1995
December 1995
Januarn 1996
Fehruary 1996
March 1996
April 1996
ey 1996

I June 1996
e

View events in the Event Screen.

Related

Categories

®

Canadian Firsts

On This Day

@

Periods

®

Search by Date

@

Click here for a complete description of the Timeline Screen.



Timeline

Canadian Firsts

To search the list of Canadian Firsts
%ick on the Canadian Firsts Button.
Double click on an event.

g:roll down the list using the scroll bar.

View events in the Event Screen.

Related

Categories

On This Day

@

Periods

@

Search by Date

@

Year in Review

@

Click here for a complete description of the Timeline Screen.



Timeline

On This Day

To find events that happened on a specific day in history

e

Click on the On This Day Button.

Choose the year and month from the drop-down menus.
Click the Begin Search Button.

e

View events in the Event Screen.

Related

Categories

@

Canadian Firsts

Periods

e

L QN%’Q

Click here for a complete description of the Timeline Screen.



Choose a Category

All

Acts and Treaties

Arts and Literature
Colonization and Immigration
Communication and Transportation|
Demography

Dizsasters

Econarmy and Labour
Education

Elections and Prime Ministers
Ervironment

Exploration

First Mations

Law

Macleans

FPolitics and Government
Feligion

Science

Social Policy and Health
Sports

War and Defence

Women's Rights

Wiarld




Choose a Period

Al

Fre-Human
First Mations
Exploration
Lpper Canada

Lower Canada

MHew France, Last Days
Arcadia

Inited Canadas
Atlantic Colonies
World War |

Old Province of Quebec
Early Mew France
Confederation
Expansion _Growth
MHorthwe st

mortwest Coast
1920s

19305

World War |l

Feace and Prosperity
19605

1970s

1980s

1990s




Event Screen
The event screen in Timeline displays an event according to the period, category or time chosen.

L

Move the mouse over the graphic for explanations of the various functions.
o to article

Date: January 16, 1960 -~
Period: 19605

Category: Sports

Event: Gordie Howe of the Detrait Red YWing
scored one goal and assists on another to + Y
pass Maurice (Rocket) Richard as the leading .
scorer in MHL histary.




This area displays the title of the event.



This button provides a list of articles in the encyclopedia related to the current event.



Double click the thumbnail to view the picture.



This area displays the date of the current event.



This area of the event screen displays the period of the current event.



Categories Button

Click the Categories Button to display categories of events.



Periods Button

Periodss—"<

Click the Periods Button to display a list of periods in the Timeline.



Search by Date Button

T T

Sear&_—!{‘p‘lﬁa

e L
R

Clcik the Search by Date Button to search for a range of dates in the Timeline.



Year in Review Button

Click the Year in Review Button to display the main Year in Review screen and to display a list of events
from Maclean's.



Canadian First Button

L

Click the Canadian First Button to display a list of events describing Canadian accomplishments.



On This Day Button
On This Ht;:'* ¢

Click the On This Day Button to search the events that happened on a specific day in history.




Period Drop Down Menu

Click the Period Drop Down Menu to choose a period in history.



Event Title List

The Event Title List shows all the events according to the category, period or date chosen.



Main Period Screen
The Main Period Screen shows the periods of Canadian history. Click on a period to display the events of
that era.

- Scroll the main Screen by pointing the cursor off the right edge of the screen to
move right or off the right edge of the screen to move right.



Video Icon

L

The Video Icon filters videos in the multimedia list. Click this icon to view only video titles.



Hot Spots
&

Hot spots, or hypergraphics, allow the user to click on a "hot" spot on a picture and zoom to a related
subject or to a detail of the current subject, much as Cross References allow the linking of articles.

L



How to Use Hot Spots

L

Find a Hypergraphic (a map or picture containing hot spots) by using the Hot Spot icon on the Multimedia
Filter.

L

Move the cursor over the graphic until the colour reverses and the cursor turns to a pointing hand, as in
the example below:

Click on the hot spot to display the new picture.

Legends

L

Click the Legend Button to display a list of all hot spots on the graphic.

As you move your cursor over the legend, the colour reverses on the graphic to show the location of the
hot spot.

L

Click a legend item to display the hot spot picture.

Click here to view an example of a Legend.



How to Use QuickTime VR

QuickTime VR are panoramas composed of a number of images, each one shown from a different angle.
Moving around in this panorama is like moving around in the scene itself. In The Canadian Encyclopedia+
Quicktime VRs are marked with the following icon:

L

Double click on the title as you would a video or picture.

2

Move around using the following controls.

How To Windows Macintosh

Look around Click and drag the mouse Click and drag the mouse

Zoom in Press Shift Press Option

Zoom out Press Control Press Control

Jump to another Move the pointer to a jump spot Move the pointer to a jump spot

location and click and click



Canadian Firsts Button

L

Click this button to display a list of events describing Canadian landmarks and innovations.



Next Media Button

Click the Next Media Button in the Media Browser to show the next media item in the list.



Previous Media Button

Click the Previous Media Button to show the previous media item in the list.



Media by Subject Button

Click the Media by Subject Button to display a list of subjects in which the media are organized.



Media Title Dialog Box

Use the Media Title Dialog Box to enter a title of a multimedia item. The list moves alphabetically as you
type.



Media Subject List

The Media Subiject List shows a list of media topics. Expand or contract a list by clicking on the down-
facing or right-facing arrows.



Media Browser Minimize Button

Click the Media Browser Minimize Button to minimize the Media Browser. To see the Browser minimized,
view the Picture Viewer.



File Menu in Dictionary Mode

e

Dictionary Mode

&

File
Save Entry
Choose this item to save the current dictionary entry.
Print Entry
Choose this item to save the current dictionary entry
Print List
Choose this option to print the current Bookmark List.
Print Setup
Choose this option to set up your printer.
Preferences
Choose this option to set your preferences.
Exit
Choose this option to exit the program.

&

Click here to view the File Menu in Quiz Mode

&

Click here to view the File Menu in Encyclopedia Mode




File Menu in Quiz Mode

e
Quiz Mode
&
File
Preferences
Choose this option to set your preferences.
French
Choose this option to display the quiz questions in French (or in English if the current setting is
French.
Exit
Choose this option to exit the program.
e
Click here to view the File Menu in Dictionary Mode
&

Click here to view the File Menu in Encyclopedia Mode




Copy Text to an Article Note

b

To Copy text to a an Article Note

1 Copy the text to the clipboard by selecting it and selecting "Copy Selected Text" from the from the
Edit Menu.

2 In an article that has been bookmarked, double click the Note Button

e
L

3 Drop the note at the appropriate place in the article.
4 Double click the Note icon and in the List Note window, use the paste command, Ctrl+V (Windows) or
Command+V (Macintosh) to insert the selected text.



Copy Text to a Bookmark List Note

b

To Copy text to a Bookmark List Note

1 Copy the text to the clipboard by selecting it and selecting "Copy Selected Text" from the from the
Edit Menu.

2 Open the Bookmarks List window by clicking the Bookmark Button.

&

3 Double click the List Notes Button

b

4 Paste the text in the List Note window, using the paste command, Ctrl+V (Windows) or Command+V
(Macintosh).



French-English Button

Click the French-English Button to access English translations of French words in the bilingual dictionary.



English-French Button

Click the English-French Button to access French translations of English words in the bilingual dictionary.



Conjugate Button

Click the Conjugate Button to conjugate a French verb (available only in the French-English mode).



Dictionary Headwords

Dictionary Headwords show the instances in which your search term appears as part of the title of a
dictionary entry.



Dictionary Search Button

Use the Dictionary Search Button to search for all instances of your search term throughout the dictionary.



Dictionary Search Results

The Dictionary Search Results pane displays a list of dictionary entries that contain the current search
term.



Translation Window

The Translation Window displays the translation of the current term in bilingual mode or a definition in
English only mode.



Options Menu

&
Options
Anagram Length
Choose this option to set the length of anagram.

Pronounciation Key
Choose this option to display the pronouciation key of the current dictionary.



How to Browse the Subject List

Description: Browse Subjects moves through the structured subject tree
1 Click the Subjects Button

2 Click the Browse Subjects Button

L

Scroll down to a subject of interest, eg, Architecture

Click the right-pointing arrow P to display the next level
Continue clicking until you reach a subject that interests you
Click the down-pointing arrow ¥ to collapse a list

Choose an article from the Titles list

[0 e Né) BE - V)

Click here to see the Browse Subject Screen.



Browse Subject Screen

Al

= Canada

3 Canadian Culture
3 Canadian Defence

b Canadian Physical Geography

Coastal Waters
Islands

Lakes & Resermirs
Land Features




Search Subject Screen

Housing

Histary
Histarians
Histarical Figures
Histarical Theses
Heraldry
Houszehold tems

Humanities ﬂ




How to Search the Subject List

Description: Search Subjects searches all subject headings, regardless of their place in the subject tree.
1 Click the Subjects Button

2 Click the Search Subjects Button

L

3 Begin to type the subject name into the dialog box
4  As the list moves through the alphabet, choose a subject
5 Choose an article from the Titles list

Click here to see the Search Subjects Screen.



Search Subject Button

L

Click the Search Subject Button to search all the headings in the subject list. This button toggles with the
Browse Subject Button




Browse Subject Button
&

Click the Browse Subject Button to browse through the subject tree. This button toggles with the Search
Subject Button.



Click a right-pointing arrow to expand a subject list.



Click a down-pointing arrow to collapse a subject list.
Category Title List




Category Title List

Double click on a sub"ect cateio% to display a list of titles.

|Avalun Peninzula |

QuickSearch

4 Booathia Peninsula
8 Bruce Peninsula
¥ Cap des Rosiers, Anse du
i Cape Blomidan

#8 Cape Bonavista

$8 Cape Kildare




Search Subject Dialog Box

Type a subject name into the Search Subject Dialog Box to move alphabetically through the entire list of
subjects.



Timeline Go Back Button

Click the Timeline Go Back Button to go back to the main (All) screen in Period or Categories.



Begin Search Button

Click the Begin Search Button to begin a search once you have entered your search terms.



Boolean Search Screen

Use Boolean searches for simple word searches or for searches in which the relationship between search
terms is known.

Click here for more detailed information on Boolean Searches.



SmartSearch Screen

Use SmartSearch for general searches expressed in common language. SmartSearch ranks answers by
how appropriate they are to the search terms.

You may enter words or guestions
that describe your research or Interest.

What are the ongins of French

Canadian nationalizsm?

sotingon [ Tuner | |_nep |
]
¢

Click here for more detailed information on SmartSearches.



Clear Entry Button

Click the Clear Entry Button to clear the search dialog box.



Boolean Drop Down List

Click the Boolean Drop Down List to display a list of Boolean operators. Click one of the operators to
include it in your search.



Boolean Dialog Entry Box

Use the Boolean Dialog Entry Box to enter your search term.



Delete Article Button

The Delete Article Button deletes the item from the Bookmark List.



Close Media Button

Click the Close Media Button to close the Media Browser.



Previous Button

Use the Previous Button to go back to the original picture after you have clicked a hot spot.



Browser Maximize Button

Click the Browser Maximize Button to restore the Multimedia Browser to its full size.



Legend
A legend lists the titles of all the hot spots in a hypergraphic.

Click the Legend Button to display the legend.

L

Move the mouse over the legend titles to see the locations of the items on the graphic.

L

Click a title on the legend to display the picture.

previous | view legend




Spelling Button

Use the Spelling Button to check the spelling of your search terms.



Subject Window Close Button

Use the Subject Window Close Button to close the Subject Window.



Event Category

The Event Category shows the category of the current event.



The text in this area describes the event.



Timeline Screen Hypergraphic

Click on areas of the screen for descriptions. Click the Close Button to exit Help.
\ The Canadian Encyclopedia Plus - [untitled]

Age of Dinosaurs Begins
Small Primates Appear
First Humans Appear
Morth Armerican Glaciation !
Humans LIse First Tools Date: 20 thousand years ago to 50
Wisconsin Glaciation Bedins thousand years ago

First Mations Cross Beringia Period: Pre-Human

Bone Scraper at Old Crow :
FirStCaveFIJ:'aintinga Category: Environment

Event: The age of mammals.
Animals such as mastodons and
mammoths, horses, camels and
giant sloths moved into the Americas.

| |

Bin Game Hunters

|ce-free Corridars

Bluefish Caves

Miagara Falls Created
Clovis and Folsom Cultures
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Event Screen

The event screen carries the definition of the timeline event.

Click here for more information on the Event Screen.



Boolean Search

Use Boolean search to find specific topics in which you know the relationship between your terms.

Click here for more detailed information on Boolean Searches.



SmartSearch

Use SmartSearch to find answers to simple or complex queries in which the results are ranked in order in
which the program matches and evelautes your terms. SmartSearch queries can be entered in common
sentences or as questions.



Timeline Related Article Button

Click the Timeline Related Article button to go to articles related to the event described.



Internet Updates

Internet updates are available for users of The Canadian Encyclopedia+. These updates are available
from The Canadian Encyclopedia site on the World Wide Web.

Click here for @Internet Access to The Canadian Encyclopedia+ Web Site.

Follow the instructions to download the self-extracting file from the Web site.

e

Click here for step-by-step instructions on How to Install Updates.



How to Install Updates

1 Create a temporary directory on your hard disk, (for example, c:\cdntemp) or use an existing temporary
directory, such as C:\temp.

2 Copy the file UPDATES.EXE from the CD-ROM into this directory.

3 Run the UPDATES.EXE file that you have downloaded from the Web site by double clicking the file in
file manager (or by using Run from the Windows 95 Start Menu). Several update files will expand into the
directory, including SETUP.EXE.

4 Now run the SETUP.EXE program. Follow the on-screen prompts to install the update.

5 When you have finished installing the update, you can delete the files from the temporary directory.

6 The next time you run the Encyclopedia, use the "Internet Updates" option from the Search Menu.



Media Results List

The Media Results List shows the number of items in the media list according to the subject and filter
chosen.



Media Subject Close Button

Use this button to close the Subject List/



SmartSearch Question

A SmartSearch question can be a word, combination of words, question or paragraph.



Search Drop Down Menu

from:

1943 | AD +| Sep -|
L

1945 | AD | Dec |




Consultants for the 1996 Edition

The following were some of the people who dedicated their time and expertise to reading, evaluating and
revising the articles in The Canadian Encyclopedia.

Robert S. Anderson
Research Scientist

Canadian Museum of Nature
Ottawa

(SCIENCE: Biology - Zoology)

Jeff Bateman

Senior Editor

The Record

Vancouver

(HUMANITIES: Music - Popular)

John Beckwith

Composer

Toronto

Professor Emeritus, Faculty of Music
University of Toronto

(HUMANITIES: Music - Classical)

Kerri Calvert

Librarian

Sociology Information Centre
University of Alberta

(SOCIAL SCIENCES: Sociology)

Rama Chengalath

Research Scientist

Canadian Museum of Nature
Ottawa

(SCIENCE: Biology - Zoology)

Cecile Clayton-Gouthro

Assistant Professor of Clothing and Textiles
University of Manitoba

(HUMANITIES: Art - Design)

Brian W. Coad

Research Scientist

Canadian Museum of Nature
Ottawa

(SCIENCE: Biology - Zoology)

Francis R. Cook

Researcher Emeritus
Canadian Museum of Nature
Ottawa

(SCIENCE: Biology - Zoology)

Penny Cousineau
Associate Professor of Photography
Concordia University



(HUMANITIES: Art - Photography)

Michael Crabb

CBC

Toronto

(HUMANITIES: Dramatic - Dance)

Curatoral Staff

Canadian Museum of Contemporary Photography
Ottawa

(HUMANITIES: Art - Photography)

Department of Biological Sciences
University of Alberta
(SCIENCE: Biology - Botany)

Wayne Enright

Professor and Chair of Computer Science
University of Toronto

(SCIENCE: Electronics and Computers)

Curtis Fahey
Multicultural History Society of Ontario
Toronto

Gerald L. Gall

Professor of Law

University of Alberta

(SOCIAL SCIENCES: Government - Law)

Bruce Grenville

Senior Curator

Edmonton Art Gallery

Edmonton

(HUMANITIES: Art - Painter and Painting, Sculptors)

Charles C. Hill

Curator of Canadian Art

National Gallery of Canada

Ottawa

(HUMANITIES: Art - Painter and Painting, Sculptors)

Larry LeBlanc

Canadian Editor

Billboard

Toronto

(HUMANITIES: Music - Popular)

Steven McLean

News Editor

The Record

Toronto

(HUMANITIES: Music - Popular)

Gerald R. McMaster
Curator of Contemporary Indian Art



Canadian Museum of Civilization
Hull
(HUMANITIES: Art - Native Art)

Michael McMordie

Professor of Architecture, Faculty of Environmental Design;
Professor of General Studies

University of Calgary

(HUMANITIES - Architecture)

Lee-Ann Martin

First Peoples Equity Coordinator
The Canada Council

Ottawa

(HUMANITIES: Art - Native Art)

Mark Miller

Jazz Critic and Historian
Toronto

(HUMANITIES: Music - Jazz)

Charles H. Moore

Professor Emeritus, Faculty of Arts
University of Alberta
(HUMANITIES: Art - Native Art)

Diana Nemiroff

Curator of Contemporary Art

National Gallery of Canada

Ottawa

(HUMANITIES: Art - Painter and Painting, Sculptors)

Kelly Okamura

DesignLink

Toronto

(HUMANITIES: Art - Design)

Henri Ouellet

Professeur associé de sciences biologiques
Université de Montréal

(SCIENCE: Biology - Zoology)

Carol Outram

DesignLink

Toronto

(HUMANITIES: Art - Design)

Donald Pattie

Instructor, Wildlife Program
Northern Institute of Technology
Edmonton

(SCIENCE: Biology - Zoology)

Richard L. Plant
Professor of Drama
Queen's University;



Professor of Drama, Graduate Centre for Study of Drama
University of Toronto
(HUMANITIES: Dramatic - Theatre)

Dennis Reid

Curator of Canadian Art

Art Gallery of Ontario

Toronto

(HUMANITIES: Art - Painter and Painting, Sculptors)

Joe Sawchuk

Associate Professor of Native Studies
Brandon University

(NATIVE PEOPLE)

Geoffrey Simmims

Associate Professor of Art History
University of Calgary
(HUMANITIES: Architecture)

David Staines

Professor of English
University of Ottawa
(HUMANITIES: Literature)

J.T. Stevenson

Professor Emeritus of Philosophy
University of Toronto

(SOCIAL SCIENCES: Philosophy)

George Swinton

Professor Emeritus

Carleton University;

Artist and Author

Winnipeg

(HUMANITIES: Art - Native Art)

Dixon Thompson

Professor, Faculty of Environmental Design
University of Calgary

(SCIENCE: Biology - Ecology)

Arjen Verkaik

Skyart Productions

Elmwood, Ont

(SCIENCE: Earth - Meterology)

Claire Versailles

Encyclopedia of Music in Canada
Montréal

(HUMANITIES: Music - Classical)

Patricia Wardrop

Research Associate and Indexer

Encyclopedia of Music in Canada (1981, 1992 editions)
Toronto



(HUMANITIES: Music - Classical)

Norman Zepp

Independent Curator/Consultant
Saskatoon

(HUMANITIES: Art - Native Art)



View Legend Button

Click the View Legend Button to view a list of hotspots available in the current hypergraphic. This button
only appears when the picture or map contains hotspots.



SmartSearch Results

The SmartSearch Results are ranked in order of importance. The results list includes pictures as well as
articles.



Back to SmartSearch Button

Click this button to return to the SmartSearch screen to enter a new question.



Preview Screen

The Preview Screen shows the search terms as highlighted words in the text and automatically takes you
to the first match.






